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PC*MILER® Product Line
END-USER LICENSE AGREEMENT

Grant of License: Subject to the terms, conditions, use limitations and payment of fees as
set forth herein, ALK Technologies, Inc. ("ALK") grants the end-user ("you") a non-
assignable, non-transferable, non-exclusive license to install and use the PC*MILER
solution(s) (including traffic data or any other subscriptions as applicable) you have
purchased ("PC*MILER") on a single personal computer. The PC*MILER software, data
and documentation are provided for your personal, internal use only and not for

resale. They are protected by copyright held by ALK and its licensors and are subject to the
following terms and conditions which are agreed to by you, on the one hand, and ALK and
its licensors (including their licensors and suppliers) on the other hand.

Title: You acknowledge that the PC*MILER computer programs, data, concepts, graphics,
documentation, manuals and other material owned by, developed by or licensed to ALK,
including but not limited to program output (together, "program materials"), are the exclusive
property of ALK or its licensors. You do not secure title to any PC*MILER program materials
by virtue of this license.

Copies: You may make one (1) copy of the PC*MILER program materials, provided you
retain such copy in your possession and use it solely for backup purposes. You agree to
reproduce the copyright and other proprietary rights notices of ALK and its licensors on such
a copy. Otherwise, you agree not to copy, reverse engineer, interrogate, or decode any
PC*MILER program materials or attempt to defeat protection provided by ALK for preventing
unauthorized copying or use of PC*MILER or to derive any source code or algorithms
therefrom. You acknowledge that unauthorized use or reproduction of copies of any
program materials or unauthorized transfer of any copy of the program materials is a serious
crime and is grounds for suit for damages, injunctive relief and attorney's fees.

Limitations on Transfer: This license is granted to you by ALK. You may not directly or
indirectly lease, sublicense, sell, disseminate, or otherwise transfer PC*MILER or any
PC*MILER program materials to third parties, or offer information services to third parties
utilizing the PC*MILER program materials without ALK's prior written consent. To comply
with this limitation, you must uninstall and deactivate PC*MILER from your computer prior to
selling or transferring that computer to a third party.

Anti-Piracy Protection: PC*MILER may include product activation and other technology to
prevent unauthorized use and copying. If provided with an install product key code (the
"Product Key Code"), or any other similar mechanism, you will need to activate PC*MILER
with the associated method in order to use it. If you try to activate or install an excessive or
unauthorized number of times or in an unauthorized environment, the ALK Anti-Piracy
Protection may cause PC*MILER to lock and prevent you from further activating or using
PC*MILER. Refer to ALK's help page at https://activate.alk.com for more information about
our Product Activation and Anti-Piracy Protection.

Limitations on Network Access: You may not allow end-users or software applications on
other computers or devices to directly or indirectly access this copy of PC*MILER via any
type of computer or communications network (including but not limited to local area
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networks, wide area networks, intranets, extranets, the internet, virtual private networks, Wi-
Fi, Bluetooth, and cellular and satellite communications systems), using middleware
(including but not limited to Citrix MetaFrame and Microsoft Terminal Server) or otherwise
(including but not limited to access through PC*MILER interface products), or install or use
PC*MILER on a network file server, without first notifying ALK, executing a written
supplemental license agreement, and paying the license fee that corresponds to the number
and types of uses to which access is to be allowed.

Limitations on Data Extraction: You may manually extract data (including but not limited to
program output such as distances, maps, and driving directions) from PC*MILER and use it
in other applications on the same computer on which PC*MILER is legally licensed and
installed, as permitted below. You may not transfer data extracted from PC*MILER onto any
other computer or device unless you have licensed PC*MILER for that computer or

device. You agree that you will not, nor will you permit your trade partners or anyone else
to, use content derived from PC*MILER, including route line data, nor display such data or
integrate such data into another provider's service, including, but not limited to, Google or
Bing. You agree not to pre-fetch, retrieve, cache, index, or store any data, content, or other
portion of the product output at any time, provided, however, that you may temporarily store
(for less than thirty (30) days) limited amounts of such content for the sole and exclusive
purpose of enhancing the performance of your implementation due to network latency, and
only if you do so securely and in a manner that: (a) does not permit use of the content
outside of the scope of this Agreement; (b) does not manipulate or aggregate any content or
portion thereof; (c) does not prevent ALK from accurately tracking usage; and (d) does not
modify attribution of the product in any way.

Limitations on Mobile Communications: Without limiting the generality of the foregoing, you
may not transmit PC*MILER street-level driving directions through mobile communications
systems such as satellite, or cellular services or to mobile devices such as computers,
telematics systems, on board or mobile computers or Smartphones, handhelds, pagers,
electronic recording devices or telephones without first executing a written supplemental
license agreement with ALK and paying the license fee that corresponds to the number and
types of devices and systems to and through which transmission is to be permitted.

Limitations on Disclosure: You may disclose PC*MILER distances to trading partners, in the
course of their providing services to you, for specific origin-destination moves for which you
provide transportation services and use PC*MILER distances as a basis for payment. You
may not make any other disclosure of PC*MILER programs and materials, including, but not
limited to, program output, to anyone outside the legal entity that paid for and holds this
license, without prior written permission of ALK. You acknowledge that the PC*MILER
programs and materials, developed by or licensed to ALK are very valuable to ALK and its
licensors, and their use or disclosure to third parties, except as permitted by this license or
by a written supplemental license agreement with ALK, is strictly prohibited.

Security: You agree to take reasonable and prudent steps to safeguard the security of the
PC*MILER program materials and to notify ALK immediately if you become aware of the
theft or unauthorized possession, use, transfer or sale of the PC*MILER program materials
licensed to you by ALK.

Acceptance: You are deemed to have accepted the PC*MILER program materials upon
receipt.
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Warranties: ALK represents and warrants that:

a) For ninety (90) days from date of purchase, PC*MILER, when delivered and properly
installed, will function substantially according to its specifications on a computer
purchased independently by you.

b) For ninety (90) days from date of purchase, the software media on which ALK provides
PC*MILER to you will function substantially free of errors and defects. ALK will replace
defective media during the warranty period at no charge to you unless the defect is the
result of accident, abuse, or misapplication of the product.

c) THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITING THE GENERALITY OF THE
FOREGOING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR USE. THE PC*MILER PROGRAM, DATA AND DOCUMENTATION IS
SOLD "AS IS". IN NO EVENT SHALL ALK OR ITS LICENSORS BE LIABLE FOR ANY
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES SUCH AS, BUT NOT
LIMITED TO, LOSS IN CONNECTION WITH OR ARISING OUT OF THE EXISTENCE
OF THE FURNISHING, FUNCTIONING OR USE OF ANY ITEM OF SOFTWARE,
DATA OR SERVICES PROVIDED FOR IN THIS AGREEMENT. IN NO EVENT SHALL
DAMAGES TO WHICH ALK MAY BE SUBJECT UNDER THIS AGREEMENT EXCEED
THE CONTRACT PRICE. THIS WARRANTY SHALL NOT ACCRUE TO THE BENEFIT
OF THIRD PARTIES OR ASSIGNEES.

Disclaimer: The data may contain inaccurate, incomplete or untimely information due to
the passage of time, changing circumstances, sources used and the nature of collecting
comprehensive geographic data, any of which may lead to incorrect results. PC*MILER's
suggested routings, fuel and traffic data are provided without a warranty of any kind. The
user assumes full responsibility for any delay, expense, loss or damage that may occur as
a result of their use.

Termination: This Agreement will terminate immediately upon any of the following events:

a) If you seek an order for relief under the bankruptcy laws of the United States or similar
laws of any other jurisdiction, or a composition with or assignment for the benefit of
creditors, or dissolution or liquidation, or if proceedings under any bankruptcy or
insolvency law are commenced against you and are not discharged within thirty (30)
calendar days.

b) If you materially breach any terms, conditions, use limitations, payment obligations, or
any other terms of this Agreement.

c) Upon expiration of any written supplemental license agreement between you and ALK of
which this license is a part.

Obligations on Termination: Termination or expiration of this Agreement shall not be
construed to release you from any obligations that existed prior to the date of such
termination or expiration.

Hold Harmless and Indemnity: Except as otherwise provided in your agreement with ALK,
the following article applies: To the maximum extent permitted by applicable law, you agree
to hold harmless and indemnify ALK and its parent company, subsidiaries, affiliates,
officers, agents, licensors, owners, co-branders, other partners, and employees from and
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against any third party claim (other than a third party claim for Intellectual Property Rights)
arising from or in any way related to your use of PC*MILER, including any liability or
expense arising from all claims, losses, damages (actual and/or consequential), suits,
judgments, litigation costs and attorney's fees, of every kind and nature. ALK shall use
good faith efforts to provide you with written notice of such claim, suit or action.

Disclosure for Products Containing Certain Data:

a) Historical or Real-time Traffic data: traffic data, including historical traffic data, is
licensed as an optional subscription service which must be renewed annually for
continued use. ALK and its licensor(s) will use commercially reasonable efforts to make
traffic data available at least 99.5% of the time each calendar month, excluding minor
performance or technical issues as well as downtime attributable to necessary
maintenance, and Force Majeure.

This data is provided to you "as is," and you agree to use it at your own risk. ALK and its
licensors (and their licensors and suppliers) make no guarantees, representations or
warranties of any kind, express or implied, arising by law or otherwise, including but not
limited to, content, quality, accuracy, completeness, effectiveness, reliability, fithess for a
particular purpose, usefulness, use or results to be obtained from this Data, or that the
Data or server will be uninterrupted or error-free.

Limitations on Export: You hereby expressly agree not to export PC*MILER, in whole or in
part, or any data derived therefrom, in violation of any export or other laws or regulations of
the United States. You acknowledge and agree that ALK commodities, technology or
software that will be exported from the United States will be in accordance with U.S. Export
Administration Regulations. Diversion contrary to U.S. law is prohibited. Export or re-export
of ALK goods may require an export license or may be prohibited as it pertains to
commodities, technology or software of U.S. origin.

Aggregated Data: Except as otherwise provided in your agreement with ALK, the following
article applies: ALK may, from time to time, share information about You with parent and
sister or affiliated companies for business purposes and when necessary for it to perform
work under this End User License Agreement. In addition, ALK may, and is hereby
authorized to, use, share and provide certain aggregated, non-identifiable information
derived from Your use of PC*MILER to third parties.

ALK Cloud Feature: ALK Cloud feature, if used, will store in an anonymized way Your data
in a cloud account in order to allow You to securely synchronize Your data with other users
in Your organization. End-User data is deemed the confidential information of the End-
User. For more information, you may refer to ALK's Privacy Policy.

Internet-Based Services Components: Certain features of PC*MILER require connection to
the Internet directly or through a wireless connection in order to function. Such features
may result in the transfer of certain data over such connection, which may or may not be
encrypted. You are solely responsible for obtaining any necessary Internet, data or wireless
subscription plans with the applicable service providers and you must comply with
applicable third party terms of agreement when using PC*MILER. You further acknowledge
that ALK is not responsible for the availability of the Internet or wireless connections or the
security or integrity of data transmitted over such connections.
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Geographic Restrictions: The Content and Services (as defined below) are provided for
access for different areas in the world. You acknowledge and agree that you may not be
able to access all or some of the same Content and Services depending as to where you
are located in the world. Access to PC*MILER may not be legal by certain persons or in
certain countries. At all times, you are responsible for compliance with local laws.

Content and Services: PC*MILER may provide you with access to ALK's proprietary
websites including without limitation at www.alk.com (the "Website") and products and
services accessible thereon, and certain features, functionality, and content accessible on
or through PC*MILER may be hosted on the Website (collectively, "Content and
Services"). Your access to and use of such Content and Services are governed by this
License and the Website's terms of use located at www.alk.com, which are incorporated
herein by this reference. Your access to and use of such Content and Services may
require you to acknowledge your acceptance of such terms of use and/or to register with
the Website, and your failure to do so may restrict you from accessing or using certain of
PC*MILER's features and functionality. Any violation of such terms of use will also be
deemed a violation of this License. ALK DOES NOT PROVIDE ANY WARRANTY FOR,
OR GUARANTEE THE AVAILABILITY OF, PRODUCTS AND SERVICES PURCHASED
OR ADVERTISED THROUGH THE APPLICATION.

Technical Support: For one (1) year from date of purchase, ALK will provide you technical
support on the PC*MILER product(s) purchased to those that are current on their payment.

Disclosure for Optional Content Displayed in PC*MILER for Additional Purchase: Traffic
data, including historical traffic data, and any other optional content licensed as a
subscription service must be renewed annually for continued use. You agree and
acknowledge that ALK is not responsible for the content displayed which belongs to third
parties, and advising you for the end of your subscription.

Additional Use Terms, Conditions, Restrictions and Obligations: This Agreement and your
use of PC*MILER is expressly subject to the ALK Privacy Policy and the HERE and ALK
End User License Agreement terms and conditions respectively ("HERE EULA") and
("ALK EULA") set forth below. YOU ACKNOWLEDGE AND AGREE THAT YOU MAY NOT
USE PC*MILER IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF BOTH
THE HERE AND ALK EULA AND YOU ACKNOWLEDGE THAT YOU HAVE REVIEWED
AND ACCEPT THE TERMS AND CONDITIONS OF BOTH THE HERE AND ALK EULA
BY INSTALLING OR ACTUALLY USING PC*MILER.

Copyright: United States copyright law and international treaty provisions protect
PC*MILER and the data transmitted by PC*MILER. You agree that no title to the
intellectual property in PC*MILER or the data is transferred to you. You further
acknowledge that title and ownership rights will remain the exclusive property of ALK or its
licensors, and you will not acquire any rights to PC*MILER or the data except as expressly
set out in this license. You agree that any copies of PC*MILER will contain the same
proprietary notices that appear on and in PC*MILER. The Copyright to PC*MILER is held
by ALK Technologies, Inc., 1 Independence Way, Princeton, NJ 08540 USA. Full contact
details are available at www.alk.com.

Miscellaneous: This agreement shall be construed and applied in accordance with the laws
of the State of New Jersey. The Courts of the State of New Jersey shall be the exclusive
forum for all actions or interpretation pertaining to this agreement. Any amendments or
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addenda to this agreement shall be in writing executed by all parties hereto. This is the
entire agreement between the parties and supersedes any prior or contemporaneous
agreements or understandings. Should any provision of this agreement be found to be
illegal or unenforceable, then only so much of this agreement as shall be illegal or
unenforceable shall be stricken and the balance of this agreement shall remain in full force
and effect.

Date: This EULA was last updated on August 9, 2017. Visit https://www.pcmiler.com/eula
for regular updates.

General Content Terms and Conditions

The following terms shall apply to the use of map data for the countries specified below
to the extent that your product and/or services uses map data for each respective
country:

FOR HERE DATA

This end user license agreement applies to HERE data included in your Software
("HERE EULA"), if any, as well as to HERE data you obtain separately that is formatted
for use with your Software.

The data ("Data") is provided for your personal, internal use only and not for resale. Itis
protected by copyright, and is subject to the following terms and conditions which are
agreed to by you, on the one hand, and ALK Technologies Inc. ("ALK") and its licensors
(including their licensors and suppliers) on the other hand.

© 2017 HERE. All rights reserved.

Personal Use Only: You agree to use this Data together with PC*MILER for the solely
personal, non-commercial purposes for which you were licensed, and not for service
bureau, time-sharing or other similar purposes. Accordingly, but subject to the
restrictions set forth in the following paragraphs, you may copy this Data only as
necessary for your personal use to (i) view it, and (ii) save it, provided that you do not
remove any copyright notices that appear and do not modify the Data in any way. You
agree not to otherwise reproduce, copy, modify, decompile, disassemble or reverse
engineer any portion of this Data, and may not transfer or distribute it in any form, for
any purpose, except to the extent permitted by mandatory laws. Multi-disc sets may only
be transferred or sold as a complete set as provided by ALK and not as a subset thereof.

Restrictions: Except where you have been specifically licensed to do so by ALK, and
without limiting the preceding paragraph, you may not (a) use this Data with any
products, systems, or applications installed or otherwise connected to or in
communication with vehicles, capable of vehicle navigation, positioning, dispatch, real
time route guidance, fleet management or similar applications; or (b) with or in
communication with any positioning devices or any mobile or wireless-connected
electronic or computer devices, including without limitation cellular phones, palmtop and
handheld computers, pagers, and personal digital assistants or PDAs.


https://www.pcmiler.com/eula

PC*MILER-AS400 User’s Guide Vil

Warning: The Data may contain inaccurate or incomplete information due to the passage
of time, changing circumstances, sources used and the nature of collecting
comprehensive geographic data, any of which may lead to incorrect results.

No Warranty: This Data is provided to you "as is," and you agree to use it at your own
risk. ALK and its licensors (and their licensors and suppliers) make no guarantees,
representations or warranties of any kind, express or implied, arising by law or
otherwise, including but not limited to, content, quality, accuracy, completeness,
effectiveness, reliability, fitness for a particular purpose, usefulness, use or results to be
obtained from this Data, or that the Data or server will be uninterrupted or error-free.

Disclaimer of Warranty: ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS
AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR IMPLIED, OF
QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE OR NON-INFRINGEMENT. Some States, Territories and Countries do not
allow certain warranty exclusions, so to that extent the above exclusion may not apply to
you.

Disclaimer of Liability: ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS
AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT OF ANY CLAIM,
DEMAND OR ACTION, IRRESPECTIVE OF THE NATURE OF THE CAUSE OF THE
CLAIM, DEMAND OR ACTION ALLEGING ANY LOSS, INJURY OR DAMAGES,
DIRECT OR INDIRECT, WHICH MAY RESULT FROM THE USE OR POSSESSION OF
THE INFORMATION; OR FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS OR
SAVINGS, OR ANY OTHER DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF OR INABILITY TO
USE THIS INFORMATION, ANY DEFECT IN THE INFORMATION, OR THE BREACH
OF THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN CONTRACT OR
TORT OR BASED ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some States, Territories and
Countries do not allow certain liability exclusions or damages limitations, so to that
extent the above may not apply to you.

Export Control: You agree not to export from anywhere any part of the Data provided to
you or any direct product thereof except in compliance with, and with all licenses and
approvals required under, applicable export laws, rules and regulations.

Entire Agreement: These terms and conditions constitute the entire agreement between
ALK (and its licensors, including their licensors and suppliers) and you pertaining to the
subject matter hereof, and supersedes in their entirety any and all written or oral
agreements previously existing between us with respect to such subject matter.

Governing Law: The above terms and conditions shall be governed by the laws of
lllinois, without giving effect to (i) its conflict of laws provisions, or (ii) the United Nations
Convention for Contracts for the International Sale of Goods, which is explicitly
excluded. You agree to submit to the jurisdiction of the Illinois for any and all disputes,
claims and actions arising from or in connection with the Data provided to you
hereunder.

Government End Users: If the Data is being acquired by or on behalf of the United
States Government or any other entity seeking or applying rights similar to those
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customarily claimed by the United States government, the Data is a "commercial item"
as that term is defined at 48 C.F.R ("FAR") 2.101, is licensed in accordance with End-
User Terms and each copy of Data delivered or otherwise furnished shall be marked and
embedded as appropriate with the following "Notice of Use" and shall be treated in
accordance with such Notice.

Notice of Use

Contractor (Manufacturer/Supplier) Name: HERE

Contractor (Manufacturer/Supplier) Address: 425 W. Randolph Street, Chicago, Illinois
60606

This Data is a commercial item as defined in FAR 2.101 and is subject to these End
User Terms under which this Data was provided

© 2017 HERE. All rights reserved

If the Contracting Officer, federal government agency, or any federal official refuses to
use the legend provided herein, the Contracting Officer, federal government agency, or
any federal official must notify HERE prior to seeking additional or alternative rights in
the Data.

FOR ALK DATA

This end user license agreement applies to ALK Data included in PC*MILER if any, as
well as to ALK data you obtain separately that is formatted for use with your Software
("ALK EULA").

The data ("Data") is provided for your personal, internal use only and not for resale. Itis
protected by copyright, and is subject to the following terms and conditions which are
agreed to by you, on the one hand, and ALK Technologies, Inc. ("ALK") and its licensors
(including their licensors and suppliers) on the other hand.

© 2017 ALK. All rights reserved.

Personal Use Only: "You" means you as an End-user or as a "Company" on behalf of
its End-Users which are subject to either a Non-Disclosure Agreement as employees or
a License Agreement that contains the same restrictions as herein as a Value Added
Reseller. Also as used in this EULA "personal use" can also be understood in more
general terms as for a Company's use. You agree to use this Data together with
PC*MILER for the solely personal, non-commercial purposes for which you were
licensed, and not for service bureau, time-sharing or other similar

purposes. Accordingly, but subject to the restrictions set forth in the following
paragraphs, you may copy this Data only as necessary for your personal use to (i) view
it, and (ii) save it, provided that you do not remove any copyright notices that appear and
do not modify the Data in any way. You agree not to otherwise reproduce copy, modify,
decompile, disassemble or reverse engineer any portion of this Data, and may not
transfer or distribute it in any form, for any purpose, except to the extent permitted by
mandatory laws.

Restrictions: Except where you have been specifically licensed to do so by ALK in the
case of an integrated solution bundled or intended for use with specific smartphones,
similar mobile communication device(s) or personal navigation device(s), and without
limiting the preceding paragraph, you may not use this Data (a) with any products,
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systems, or applications installed or otherwise connected to or in communication with
vehicles, capable of vehicle navigation, positioning, dispatch, real time route guidance,
fleet management or similar applications; or (b) with or in communication with any
positioning devices or any mobile or wireless-connected electronic or computer devices,
including without limitation cellular phones, smartphones, palmtop and handheld
computers, pagers, and personal digital assistants or PDAs.

Warning: The Data may contain inaccurate, untimely or incomplete information due to
the passage of time, changing circumstances, sources used and the nature of collecting
comprehensive geographic data, any of which may lead to incorrect results. The Data is
based on official highway maps, the Code of Federal Regulations, and information
provided by state governments and other licensors. It is provided without a warranty of
any kind. The user assumes full responsibility for any delay, expense, loss or damage
that may occur as a result of use of the Data.

No Warranty: This Data is provided to you "as is," and you agree to use it at your own
risk. ALK and its licensors (and their licensors and suppliers) make no guarantees,
representations or warranties of any kind, express or implied, arising by law or
otherwise, including but not limited to, content, quality, accuracy, completeness,
effectiveness, reliability, fitness for a particular purpose, usefulness, use or results to be
obtained from this Data, or that the Data or server will be uninterrupted or error-free.

Disclaimer of Warranty: ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS
AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR IMPLIED, OF
QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE OR NON-INFRINGEMENT. Some States, Territories and Countries do not
allow certain warranty exclusions, so to that extent the above exclusion may not apply to
you.

Disclaimer of Liability: ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS
AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT OF ANY CLAIM,
DEMAND OR ACTION, IRRESPECTIVE OF THE NATURE OF THE CAUSE OF THE
CLAIM, DEMAND OR ACTION ALLEGING ANY LOSS, INJURY OR DAMAGES,
DIRECT OR INDIRECT, WHICH MAY RESULT FROM THE USE OR POSSESSION OF
THE INFORMATION; OR FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS OR
SAVINGS, OR ANY OTHER DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF OR INABILITY TO
USE THIS INFORMATION, ANY DEFECT IN THE INFORMATION, OR THE BREACH
OF THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN CONTRACT OR
TORT OR BASED ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some States, Territories and
Countries do not allow certain liability exclusions or damages limitations, so to that
extent the above may not apply to you.

Export Control: You agree not to export from anywhere any part of the Data provided to
you or any direct product thereof except in compliance with and with all licenses and
approvals required under, applicable export laws, rules and regulations.

Entire Agreement: These terms and conditions constitute the entire agreement between
ALK (and its licensors, including their licensors and suppliers) and you pertaining to the
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subject matter hereof, and supersedes in their entirety any and all written or oral
agreements previously existing between us with respect to such subject matter.

Governing Law: The above terms and conditions shall be governed by the laws of the
State of New Jersey. The courts of the State of New Jersey shall have exclusive
jurisdiction to settle any and all disputes, claims and actions arising from or in connection
with the Data provided to you hereunder. You agree to submit to such jurisdiction.

FOR CANADA TERRITORY DATA

The following provisions apply to data for Canada provided by Canada Post Corporation
as the owner of the copyright, and Statistics Canada as the owner of all intellectual
property rights, in the same data (collectively "Canada Post Data").

Neither Canada Post Data or Statistics Canada, shall be liable: (i) in respect of any
claim, demand or action, irrespective of the nature or causes of the claim whatsoever,
alleging any loss, injury or damages, direct or indirect, which may result from End User's
use or possession of Canada Post Data; or (ii) in any way for loss of revenues or
contracts, or any other consequential loss of any kind resulting from any defect in such
Canada Post Data.

End User agrees to indemnify and save harmless Canada Post and Statistics Canada
and its officers, employees, agents from all claims alleging loss, costs, expenses,
damages or injuries (including injuries resulting in death) arising out of End User's
possession or use of Canada Data.
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PC*MILER-AS400 Version Notes — Please Read

NOTE: Beginning in Version 30, the 53 Foot Trailer routing option has been
replaced with the ‘State + National Network’ routing option to better reflect
the combination in previous versions of PC*MILER’s National Network and
53 Foot Trailer Networks when the 53 Foot Trailer option was selected. The
interactive green screen PC*MILER program has not been updated to
reflect this change. Choosing either the 53 Foot Trailer or National Network
Extended Routing option will turn on the new State + National Network
option.

For Third Party applications, ALK will continue to support the use of either
the ‘N’ or ‘5’ Network Types to turn on State + National Network Routing.

The following extended routing types will also turn on State + National
Routing portion of the request:

C = National Network/Practical

D =53 Foot Trailer/Practical

E = Toll Discouraged/National Network/Practical
F = Toll Discouraged/53 Foot Trailer/Practical

H = National Network/Shortest

| = 53 Foot Trailer/Shortest

J = Toll Discouraged/National Network/Shortest
K = Toll Discouraged/53 Foot Trailer/Shortest

There were no functional changes made in the ALKWIN or ALKTLL libraries
for Version 31. If you currently have Borders Open/Closed and Use Ferry
Distance Yes/No flags when you run the alkwin/pcmiler or alktll/pcmtll
commands, your ALKWIN or ALKTLL libraries are functionally up to date.

NOTE: The following features are not supported in the AS400 product
line: Estimated Greenhouse Gas Emissions, RouteSync, TripDirect,
Entry/Exit Toll Plaza Names in Reports, and Real-time/Historical Traffic
Data.
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1.0 Introduction

Congratulations! By purchasing a PC*MILER product, you have made a
cost-effective investment in high quality software that is simple to learn and
easy to use. PC*MILER for the AS400 uses simple-to-follow menus and
requires minimal keystrokes to generate routing and mileage information.
Shortest, Practical, National Network, Toll-Discouraged, and 53" Trailer
routes can be calculated in a matter of seconds and can include up to 30
stops.

PC*MILER for the AS400 includes all the standard features found in the PC
version, including the Hub Distance Generator, Spelling Helper, route
resequencing, and user-defined time and cost estimates. You are referred
to the main PC*MILER User’s Guide for a more thorough discussion of
these features. With PC*MILER-AS400, you can quickly and easily
generate point-to-point miles, driving instructions, and mileage summaries
broken down by toll roads and freeways

PC*MILER for the AS400 utilizes a unique distributed processing solution.
This solution maximizes the efficiency of your AS400 by "farming out"
repetitive mileage calculations to a PC. With PC*MILER-AS400, you can
benefit from having a seamless mileage interface with your management
system. Interfaces have been developed for Innovative Computing
Corporation, Qualcomm, and others.

Use PC*MILER for the AS400 to audit driver logs and supplement your fuel
tax reports. Increase driver productivity by using PC*MILER's driving
instructions and trip sequencing. In addition, your purchase of PC*MILER-
AS400 will eliminate the high costs of leasing mileage systems or paying
exorbitant transaction fees.
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2.0 Hardware and Software Requirements

Because PC*MILER-AS400 employs a Client server solution, the following
hardware and software is required. The AS400 server uses SNA APPC data
queues to communicate.

2.1 System Requirements

2.1.1 Platforms

NOTE: If you are on an older version of the Windows operating
system, it is strongly recommended that if possible you upgrade to
Windows 10 for the desktop and/or Windows 2012 Server.
Additionally, ALK strongly encourages users to apply all available
Windows Updates. Without the most recent updates, PC*MILER
could fail to launch.

e Windows® 7, 8 and 10* running in 32-bit compatibility mode as
well as support for 64-bit native applications on Windows 7 and
8 — please see section 2.4 if installing connectivity products on a
64-bit machine.
* IMPORTANT: Windows 10 recommended. Windows 7
requires the Convenience Rollup update.

e AS/400

e Citrix® Metaframe and TCP/IP functionality for use with other
platforms

e Windows Server® (Windows Server 2016, Windows Server
2012, Terminal Servers, and Server 2008* including Server
2008 R2 running in 32-bit compatibility mode for the PC*MILER
user interface and on 64-bit processors for PC*MILER Connect,
Mapping, BatchPro, and Spreadsheets)

* IMPORTANT: Server 2008 requires Windows Server 2008
Service Pack 2.

NOTE: Platforms not supported include: Windows Vista, XP, Server
2000, and Server 2003.


https://answers.microsoft.com/en-us/windows/wiki/windows_7-update/how-to-update-windows-7-using-the-convenience/c2c7009f-3a10-4199-9c89-48e1e883051e
https://www.microsoft.com/en-us/download/details.aspx?id=16468
https://www.microsoft.com/en-us/download/details.aspx?id=16468
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2.1.2 Windows Requirements for PC*MILER

In Version 31, automatic installation of Microsoft® .NET
Framework 4.6.1 requires 4.5 GB, which reduces in size down
to 39 MB once it is installed. See note in section 2.4 for
exceptions.

PC*MILER - 3.1 GB hard disk space for full install (these requirements
are approximate) which includes the following add-ons:

PC*MILER|Tolls — 50 MB

PC*MILER|Hazmat — 50 MB
PC*MILER|Streets (U.S. Data) — 1.3 GB
PC*MILER|Streets (Canadian Data) — 60 MB
Canadian Postal Codes — 50 MB

Standard Point Location Codes (SPLC) — 2 MB

O O0O0OO00O0

Environment:

Stand-alone PC with a 1.5-2 GHz processor or networked personal
computers (LANs and Server/Thin Client Networks)

512 MB RAM minimum, 1 GB strongly recommended for standard
desktop users. For Citrix and Terminal Server, 200 MB RAM for each
user running PC*MILER|Connect and PC*MILER|Spreadsheets.

Other Requirements:

Minimum screen resolution 800X600
Internet connection and email address for license activation (recommended)

These additional components may also be installed:

Microsoft Visual C++ 2015 Redistributable Package (x86) — 6 MB disk
space

Microsoft .Net 4.52 via NDP46-KB3045557-x86-x64-AllOS-ENU.exe —
4.5 GB

2.1.3 PC to AS400 Connectivity Options (Not Provided by ALK)

PC with a 2+ GHz processor, 1 GB RAM recommended

Client Access Express VAR4MO or higher, also known as iSeries
Access (recommended)

Supports OS/400, i5/0S and IBMi operating systems; Version 4.2
(V4R2) and higher on IBM AS/400, System i and Power Systems™
hardware
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2.2 Accessing User’s Guides for PC*MILER Products

NOTE: You must have Adobe Acrobat Reader on your PC to properly
view a PC*MILER product’s user guide. If you do not have this program
installed already, a free copy can be downloaded from www.adobe.com.

To make Adobe Reader your default reader, from within the Adobe
Reader application:

Select the Edit menu > Preferences > General.
Click Select Default PDF Handler.

Select Adobe Reader from the drop-down.
Click Apply.

Click OK to close the Preferences dialog.

agkrwbPE

To view the user guide for any PC*MILER product on your PC without first
opening an application, click the Windows Start button > All Apps (or the
equivalent on your system) > PCMILER 31 > and select one of the .pdf files.

To search for a keyword or phrase in a user guide, use Adobe Reader’s Find
option in the Edit menu or on the tool bar.

All user guides can also be accessed at www.pcmiler.com/support.
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3.0 Installation

NOTE for Upgrading Users: There have been no changes to the
ALKWIN or ALKTLL libraries since the Version 20 release. There is no
need to upgrade your ALK library if you are currently running the Version
20 library. You can check to see if you are running the latest library by
running alkwin/pcmiler or alktll/pcmtll commands and looking for the
existence of Borders Open/Closed and Use Ferry Distance Options, and a
single red ¢ (period or dot) in the lower right hand corner of the screen at
line 24, position 75.

=] Session A - [24 x 80]

File Edit Transfer Appearance Comrmunication  Assist  Window Help

Bl =& B & % | = % %S O @
PitSerm Copy | Paste Send | Recw Display | Calar Map Record | Stop Play Cluit Clipbrd | Support

PCMiler 28.0

=

I Request Type (MI - SM - HS)
Routing Type (P=Prac - S$=Short)  _ Toll Discouraged _ National/53Ft
Hub.orOptimiae—lL B _F_or Blank) (T - Blank) (N=Ntnl 5=53ft Blank]
Borders - O(pen] C(losed)

Lustom ooty C{Ustom) -Blank

Ovrd Restrictions (Y or N) {Add-0n Products}

Mites=or—{itometera=—ti_ar K] G,C,E,F,I or R

Use Ferry Distance (Y or NJ N A,E.F.N,0,S (Continent)

Itl

ol

<= 1=1

Enter City,State,County or Zip (Press Help key for examples)

-1 OU AWK

w

10
F2=State help F3=Exit F?7=Ins stop F8=Del stop
F10=Process Fll=Restart F22=Swap stops F23=Load Trip F24=Sav Trip

I3/011

Connected to remote server/host 10.60,115,230 using port 23

NOTE for Upgrades with PC*MILER|Tolls: You cannot use any existing
ALKWIN library if you install PC*MILER|Tolls. You must use the ALKTLL
library.

PC*MILER for the AS400 works by connecting a Windows PC to your
AS400. The PC provides mileage lookups to the AS400 via data queues.
Generally, there is one common input or request queue that all users write
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to, with each user having their own output queue. The PC listens to the
input queue for mileage request packets. Within each mileage request
packet is the name of the user’s output queue. The PC does a destructive
read of the request packet, processes the request, and writes to the
specified user’s output queue.

PC*MILER for the AS400 was developed using the data queue facilities of
IBM’s Client Access Express. You must have this connectivity product
installed and properly configured on the mileage server PC.

3.1 Installation Overview

You should have received one DVD and one CD with your purchase of
PC*MILER-AS400, or one DVD and two CD’s if PC*MILER|Tolls was
purchased:

e The PC*MILER Product Line DVD which includes the complete
PC*MILER application and the AS400 Mileage Server.

e The CD contains the 400 side ALKWIN Library.

e PC*MILER|Tolls users receive a second CD with the AS400-
side ALKTLL Library.

e NOTE: ALKWIN is for use with PC*MILER and
PC*MILER|Streets without the PC*MILER|Tolls add-on
installed. ALKTLL is used for any installation that includes the
Tolls component. PC*MILER|Tolls users will also receive the
ALKWIN Library, which is only to be used when the
PC*MILER|Tolls add-on is not to be installed.

NOTE: Required PC to AS400 Connectivity Software is not provided by
ALK. You need IBM’s Client Access Express.
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3.2 AS400 Side Installation

First install the resident AS400 software on your AS400. Sign on to
QSECOFR or an account with equivalent authorities. Place the CD in the
optical drive and follow the instructions below.

NOTES for Upgrades: If you are upgrading your ALKWIN or ALKTLL
Library from an earlier version, it is recommended that you rename your
current ALKWIN [or ALKTLL] Library or clear your current library with the
CLRLIB command.

Before clearing your current library, type ‘config’ or ‘tlifig’ from the AS400
command line and write down your current default settings. These
settings will be overwritten during the library restore. After the restore of
the library, re-enter these settings by running the ALKWIN/CONFIG
command.

1. Create a library with the CRTLIB command. Type CRTLIB ALKWIN [or
ALKTLL].

2. Add the library to the current library list. Type ADDLIBLE ALKWIN [or
ALKTLL].
(Statements in the following paragraph do not apply for installations that
include PC*MILER|Tolls.)
For Innovative Computing Corporation installations, you will also need
your ICC WORK and FILE libraries in your current library list. For
Version R6, type ADDLIBLE I193FILE or ITSR6FILE and then
ADDLIBLE I93WORK or ITSR6WORK. The ICC Version 7 libraries are
IESR7WORK and IESR7FILE. (Call ICC if you don’t know which
version you are running.)

3. Command for restoring from CD:

rstlib savlib(alkwin) dev(opt02) vol(alkwin) mbropt(*all)
alwobijdif(*all) rstlib(alkwin)

or

rstlib savlib(alktll) dev(opt02) vol(alktll) mbropt(*all)
alwobjdif(*all) rstlib(alktll)

where opt02 is your CD-ROM drive.



PC*MILER-AS400 User’s Guide

Make sure all objects were restored. You can ignore security warning
messages. It is okay if MIDQUE does not restore because this file is
created later on.

NOTE: The ALKWIN [or ALKTLL] Library CD was created using Kisco
Information Systems’ BlueCD, which allows you to create AS400
readable SAVLIBs on a PC CD writer. A small percentage of users
may have difficulty restoring the ALKWIN [or ALKTLL] Library with the
above command. If you experience problems:

Type RSTLIB, then:

a. Specify the library ALKWIN [or ALKTLL] and the appropriate
optical device

b. Press <F10> for more options
c. Specify *ALL on database member options
d. Specify *ALL on allow object differences.

4. The system administrator should make the library ALKWIN or ALKTLL
available to users at sign-on time. There are two ways to insert ALKWIN
[or ALKTLL] into the library list:

a. The WRKSYSVAL command can be used by typing
WRKSYSVAL, and then searching for the QUSRLIBL entry.
Insert ALKWIN [or ALKTLL].

b. If your users are using a job description in their user profiles,
then use the CHGJOBD command (type CHGJOBD) and insert
ALKWIN or ALKTLL.

For Innovative Computing installations, a command is available to help
insert a library into the library list. ALKWIN should be the first library in
the library list. (NOTE: Run this command from a typical ICC user
account or profile, not QSECOFR). Enter the following:

ADDLIBLE ILPGMR *LAST
CHGLIBLS
(insert) ALKWIN [or ALKTLL]

5. To grant object authority to library ALKWIN, enter the following:

GRTOBJAUT (press <F4>)
object = *ALL

library = ALKWIN [or ALKTLL]
objtype = *ALL

users = *public

authority = *ALL
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NOTE: For ICC Users only (Be sure to do this!) Type config from
the AS400 command line after the restore of the library and change
the library for the location of mileage data queues from ALKWIN to
your ICC Work library and change the ICC Support Short Code
names flag from ‘N’ to ‘'Y’. Depending on the version of your ICC
software your library will be I93WORK, ITSR6WORK, or
IESR7WORK. Check with ICC for this name. For ICC R8 and
multiple company installations use ALKWIN. Do not configure an
installation that includes the PC*MILER|Tolls component to point at
an ALKWIN or ICC library.

NOTE Also: The AS400 side and the PC Side must match which
Library the Mileage Request or Input data queue resides in. You will
be prompted during the PC Side Installation for your data queue
location or there is an option to change it under the PC*MILER-AS400
Control Menu which is an option in the File drop down menu.

[
Qﬂ Session A - [24 x 80]

File Edit Transfer Appearance Communication  Assist Window  Help

Request Type . . . MI=Miles - SM=S5tate Totals - HS=Directions

Routing Type . . . P(Practicall S(Shortest)

Toll Discouraged . T(Toll) or Blank

National/53 Foot . _ N(Nationall 5(53 Foot) or Blank

Custom Routing . . C (Custom) Blank (Default)

Hub or Optimize. . H(Hub) R(Route Through Al11) F (Fixed Destination)

Ovrd Restrictions. Y or N. . . . . (Overide Heavy Truck Restrictions)

Miles / Kilometers M or K

HazMat Type. . . . G, C, E, F, T or R . .(Add-0On Data Module)

Region(Continent]. A, E, F, N, 0, or § (Worlduide Version)

Borders. . . . . . 0(0pen] - C(Closed)

Ferry Distance . . ¥ Y or N (Include Ferry Miles In Distance Totals)
Thoce Mileage Parameters Will Be Stored For All Users On The System

Input Data
P Lib = v i te ICC Users this will be your
Queue Library |/ SRy ICC WORK lib ie:IESR7WORK

Support ICC short code names N Y or N

F3=Exit without saving Press ENTER to save for all users

04/023

Connected to rermote server/host 10,60.115.230 using port 23
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For Tolls:

=] Session A - [24 x 80

File Edit Transfer Appearance Communication  Assist  Window HElp

Copll Wy
Send Hecv Dlsplay Color Man Hecard Stop P\ay Quit

PCxMILER PARAMETER DEFHULTS

MI=Miles - SM=State Totals - HS=Directions
P(Practical) S(Shortest)
N(National) 5(53 Foot) or Blank
T(Toll) or Blank

(Cash) D (Discount)
0 (Open) - C (Closed)
Y or N (Include Ferry Miles In Distance Totals)
¥ or N (Override Heavy Truck Restrictions)
M or K
C
G
A

Request Type .
Routing Type .
National/53 Foot .

Toll Discouraged .
Toll Cost .
Borders. .
Ferry Distance .
Ovrd Restrictions,
Miles / Kilometers
Custom Routing .
HazMat Type. .
Region(Continent) .

(Custom) Blank [(Default)
, C, E, F, I, R or Blank [(Add-0On Data Module)
, E, F, N, 0, or S [(Worlduide Yersion)

=1 | I=l=I<IiolH] IUHU1£

;e mileage parameters will be stored for all users on the system
InpUtl?aIa eperafAeme e e T esEs ICC Users this will be your
Queue Library /SRRy ICC WORK 1lib ie: IESR7WORK

Support ICC short code names N Y or N

F3=Exit without saving Press ENTER to save for all users

04/023

Connected to remote server/host 10,60.115.230 using port 23

3.3 PC Side Installation
STEP 1:
Make sure that Client Access Express is installed and working on the PC. (See

Appendix B: Configuring Client Access Express for Use with PC*MILER-
AS400).

STEP 2:

Click the link that was sent to you via email from ALK Technologies, or insert
the Product Line Install DVD into your DVD drive.

Start the installation by double clicking the ‘Install_PCMILER_31’ shortcut
or you can launch the setup.exe from within the ‘Installation Files’ folder.
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PC*MILER. 31 - Main Software InstallShield Wizard >

l"‘1 PCMILER Welcome to the PC*MILER 31 Main Software

Install

IMPORTAMT: If vou need azsistance dunng the install,
please contact PC*MILER Technical Support at
pomsupport@alk. com or call 1-800-377-6453 ext 2.

< Back Cahcel

When you are prompted, enter the Product Key Code that was e-mailed
to you at the time of purchase. Your product code will be in this format:

1:9,9.9,9,.0.9.9.9.9,0:9.9,9.9,.0.9,.9.9,.9.0.9,0.9,0.4

When entering the Product Key Code, dashes are not required — dashes,
spaces, or no spaces are all acceptable.

If you do not have your Product Key Code, call ALK Technologies at
800-377-6453 ext. 2 from 8:00am to 5:00pm EST Monday through Friday.
The Product Key Code unlocks the products you purchased — either
PC*MILER or PC*MILER|Streets and the AS400 Mileage Server
(PC*MILER-AS400). Both these components should appear in the
Licensed Features screen (shown on the next page) that displays after
you enter your Product Key Code and click Next.

NOTE for users upgrading from an installation of ALK|FleetSuite
Tolls: For the AS400 you will need the PC*MILER|Tolls component as
shown on the next page.

NOTE: If you are using PC*MILER-AS400 with any third party or custom
in-house software package, you CANNOT install the PC*MILER|Tolls
component as circled above without modifying that software. To use the
enlarged Tolls Cost data structures, see Chapter 7 and Appendix F for
more information.
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NOTE: As of 5/7/07, Innovative Computing Corporation (ICC) has not
released a version of their software that works with the PC*MILER|Tolls
component. ICC users should not install PC*MILER|Tolls if they intend to
use this installation in conjunction with their ICC software.

“Licensed Features” Screen for PC*MILER:

PC*MILER. 31 - Main Software InstallShield Wizard

Licensed Features

(S PCMILER

Features that will be installed indude:

SCHMILER
PC*MILER-AS/400

\ PC™MILER |64-Bit

“Licensed Features” Screen for PC*MILER|Streets:

PC*MILER. 31 - Main Software InstallShield Wizard *

Licensed Features

DPCMILER

Features that will be installed indude:

” | pcavILER

PC*MILER-AS/400
PC*MILER |Streets - Canada

PC*MILER |Streets - North America
PC*MILER. |64-Bit




PC*MILER-AS400 User’s Guide

14

“Licensed Features” Screen for PC*MILER|Tolls:

PC*MILER. 31 - Main Software InstallShield Wizard

Licensed Features ‘ i -
L  (DPCMILER
\N

Features that will be installed indude:

PC¥MILER
PC™MILER-AS/400
PC*MILER-AS/400 Tolls
PC*MILER. [Tolls

PC*MILER |o4-Bit

Click Next and in the next screen select a folder to install to, or use the
default folder (PCMILER31). Click Next again when ready.

Note: Installing to a folder called PCMILER31 is required. Do not
rename the folder after installing.

During the installation you will be prompted to enter the name of the
library for data queues. The default values are ALKWIN (without
PC*MILER|Tolls) and ALKTLL (with PC*MILER|Tolls). NOTE: ICC
users need to coordinate with Innovative to enter the proper ICC Work
Library for their release of the ICC software. Upgrading ICC users can
read the correct library by running the alkwin/config command from an
AS400 command line.

If you purchased the PC*MILER|Tolls component you will get this prompt:

- -
Question [——

7 '_"‘-.I You have requested to install both PC*MILER|Tolls and
' PCMILER-AS/400. Please answer YES if wou are interfacing to

~ Innowvative ICC), othenwise answer MO,

Answering ‘Yes’ will turn off the Tolls component and install an ICC-
compatible version of the PC Mileage Server.
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Answering ‘No’ will install the PC*MILER|Tolls version of the PC Mileage
Server. (ICC users and users of third-party or custom in-house
transportation software should click ‘Yes’ and refer to Appendix F and
Chapter 7 for instructions about using PC*MILER|Tolls with their software.)

Library for Data Queue Locations:

PC*MILER. 31 - Main Software InstallShield Wizard

Data Queue Library K
S PCMILER
\N

Please enter Library where data queues are stored.
This should match the library spedfied by the A5400 COMNFIG command

ALKWIN

Library for Data Queue Locations with PC*MILER|Tolls:

PC*MILER. 31 - Main Software InstallShield Wizard

Data Queue Library K
(DPCMILER
NN

Please enter Library where data queues are stored,
This should match the library specified by the A5400 COMFIG command

ALKTLL
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When entering your system and sign-on information, if possible use the IP
address rather than the System Name of your AS400. Be careful that the
password for the User Profile that you specify is set not to expire. Your
User Profile must have the authority to create and delete data queues in the
library that you specified in the previous dialog.

PC*MILER 31 - Main Software InstallShield Wizard

User Information ‘ J .
L DPCMILER
NN

In order to enable automatic sign-on to your AS/400 machine, PC*MILER AS/400 Interface
needs the following information

System | <IP Address or System Mame of your AS400>] |

User | <User Profile Distance Server Will Signon With = |

Password: | <Password for Above User Profile |

STEP 3:

You must activate your installation within 15 days of installing. If your
PC has internet access this is an automated process. If your PC does not
have internet access, you will have to contact ALK to receive your activation
code.

Both types of activation are described on the following pages. Note: There
is no AS400 side licensing.

To activate immediately, leave Activate license checked and click Finish
to open the ALK License Manager. (To activate at a later time, uncheck the
Activate license check box. Each time you open PC*MILER for the next
15 days, the ALK License Manager will pop up, giving you another chance
to activate the software. Or you can select All Apps (or equivalent on your
system) > PCMILER 31 > License Status in the Windows Start menu.)



PC*MILER-AS400 User’s Guide

17

PC*MILER. 21 - Main Software InstallShield Wizard

Install5 hield Wizard Complete

O PCMILER

FC*MILER 31 Install Complete

Activate licenze

You have successfully installed PC*MILER 37. Click Finish ta
exit the wizard.

¢ Back Cancel

NOTE: The 15-day grace period for activation is only available for the first
installation of Version 31 on your PC. If you are reinstalling for any reason
you will have to activate the installation before it can be used.
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Automatic License Activation:

Click Activate in the License Manager. The rest of the process is
completely automated if you have internet access on your PC. You will see
the message “License Activation Complete!” when the activation is finished.
Close the Product Activation window, then click the Windows Start menu >
All Apps (or equivalent on your system) > PCMILER 31 > License Status
and make sure that “Licensed” appears under Status in the PC*MILER
License Tool window. If so, PC*MILER is now permanently licensed.

% PCTMILER Produc

Automatic Activation

Please enter in your email address to activate your license.

Email Address: )
somenne@Ccormpany. com <
: Enter Email Address

[C] Manual Activation

< Click “Activate”

[ PC*MILER Product =

License Activation Complete!
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Manual Activation:

If the Automatic Activation process fails due to firewall security settings or
for any other reason, try activating manually. Check the Manual Activation
box. In the Manual Activation screen that appears, click the
http://activate.alk.com link to open a webpage that will provide you with an
activation code 24/7. You may need to add http://activate.alk.com or
https://activate.alk.com as a trusted site to get the activation webpage to
open. Enter the Activation Code, then click Activate. Note: You can get
access to this screen after the initial installation by clicking the Windows
Start menu > All Apps (or equivalent on your system) > PCMILER 31 >
License Status and then clicking the Activate button.

p PC*MILER Product /£

Manual Activation

1) Go to the following URL to obtain an activation code.
http://activate.alk.com/ALKActivation.aspx G————_ \\/eh page link

Product Key:
KT4L2-3B2AE-43TLT-2375K-TE263 \I

License Number

A

License #:
750815CA

2) Enter the activation code below
Activation Code:

Check “Manual
Activation”

Manual Activation <€



http://activate.alk.com/
http://activate.alk.com/
https://activate.alk.com/
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Manual Activation on a PC Without Internet Access:

Call ALK’s Technical Support during business hours (see section 10.0) and
give your technical support representative the license number from the
Manual Activation screen or the License Tool window. You'll receive an
activation code, which you can then enter in the Manual Activation screen.
Click Activate to complete the process.

When the activation process is complete, a “License Activation Complete!”
message will appear in the Product Activation window. Click the Windows
Start menu, then All Apps (or equivalent on your system) > PCMILER 31 >
License Status and make sure that “Licensed” appears under Status in the
PC*MILER License Tool window. If so, PC*MILER is now permanently
licensed. If not, call Technical Support (see section 10.0).

-
§ PC*MILER License Too

® PCMILER alk |

Product Key: Licensed Components:
KT4L2-3B2AE-437LT-2375K-T8263 PC*MILER

PC*MILER - AS/400
PC*MILER|Tells

License Mumber:
750815C6

Status:
‘ | Licensed

Deactivate Add License
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3.4 Creation of Desktop Icons

During the installation of the PC*MILER for the AS400 interface software on
the PC, an icon to start the mileage server is placed in the startup folder. If
you want to have a desktop icon, you can do a right mouse click Copy, and
then a right mouse click Paste Shortcut onto the desktop.

To do this after the initial installation, right mouse click the Start menu;
choose Open All Users (or Open on some systems); double-click the
Programs folder; double-click the Startup icon; then use the right mouse
button to Copy and Paste Shortcut on the desktop.

If you create a desktop icon any other way, the command line or target has to
read as shown below. INCORRECT ICON PROPERTIES can cause the
mileage server not to start or to return incorrectly formatted mileage!

For PC*MILER:

C:\ALK Technologies\pcmiler31\as400\SRV32.exe <space>1

NOTE: Shortcuts are unchanged with PC*MILER|Tolls installed.

NOTE: On some systems you will have to run Srv32.exe as an Administrator.
The following error is a symptom that this setting is required.

x

':0:' Error Loading Server - PCMSRNGZ.DLL.,

To make this setting do the following:

1. Right mouse click on C:\\ALK Technologies\PCMILER31\AS400\Srv32.exe.
2. Choose ‘Properties’.

3. In the ‘Compatibility’ tab check ‘Run this program as administrator’ in the
‘Privilege Section’ as below:
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! r¥32 Properties

General Compatibility | Seu:urit_l,ll Detailsl Previous R-’ersiu:unsl

[f pow have problems with this program and it worked comectly on
an earlier werzioh of ‘Windows, select the compatibility mode that

matches that earlier verzion.
Help me chooge the zettings

— Compatibility mode

[ Fun this program in compatibility mode far:

fwindaus %P (Service Pack 3) =]

— Settingz
[ Rurin 256 colors
[ Rurin 640 « 480 screen resolution
[ Dizable vizual themes
[T Dizable desktop composition
[T Disable display zzaling on high DP settings

~ Privilege Lewvel

[¥ {Fiun this program as an administrator

@ Change settings for all uzers |

X

] I Cancel

Apply
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4.0 Starting and Stopping the Mileage Server

4.1 Starting the Mileage Server

The software you installed on your dedicated PC will cause the interface to
start automatically when the PC is turned on. You can launch the Mileage
Server without restarting the PC by clicking Start menu > All Apps (or
equivalent on your system) > PCMILER 31 > AS400 Interface.

When the mileage server (SRV32.exe) starts, it displays the connection
status.

¥ PC*MILER AS400 31.0.0.0 = — O x
File Options LogFile Help
Product Type: PC*MILER

IMI File: pcmserve.ini

Starting Parameter: 1

Ini File: pcraserveini

Loading EHMDQHandler
EHMNDOHandler CK

Loading ServerHandler
PCMSRV32.DLL

ServerHandler CK

Cpening Server

Cpen Server PC*MILER 31.0 = 10000
AS400 Server Log Started
Creating Queue ALKWIN/MIDQUE
CQueue Created

Setting Data conversion mode on
Waiting for data queue request

Status: Idle

NOTE: Both the PC and the AS400 must agree on the location of the
Input or Request data queue. To change the location on the PC, click on
the mileage server’s File menu. Choose Change Library/Queue. The
change is made on the AS400 by running the alkwin/config or alktll/tllfig
command and filling out the library field.
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To have the server log written to file select the mileage server’'s Log File
menu and and highlight Append, Overwrite or Verbose (see below). This
will create the file c:\\ALK Technologies\pcmiler31\as400\as400.log. Itis
recommended to only use logging for diagnostic purposes, otherwise the
log files tend to grow large.

e Append will add to the existing as400.log file after restarts.

o Overwrite will delete the existing as400.log file after restarts.

e Verbose logging includes information from the data queue
communications. Verbose logging Appends after restarts.

4.2 Stopping the Interface

From the PC*MILER-AS400 window, choose Exit from the File menu.

4.3 Configuring the Use of Mexican Postal Codes

Version 31 of PC*MILER includes over 25,000 Mexican postal codes in the
database that provide comprehensive coverage of Mexico. Mexico and the United
States use the same five-digit numbering scheme for their postal codes. The two
countries share a large number of common codes and care must be taken so that
users do not accidentally match a Postal or ZIP code to the wrong country. By
default, all Mexican postal codes are ignored.

To turn on access to Mexican postal codes, click the Options dropdown menu,
choose Default Zip Codes and highlight your choice.

Choose between:

Use default US Zip Code: This is the default setting. All Mexican postal
codes will be ignored.

Use default Mexican Zip Code: Turns on the use of Mexican postal
codes. If a user specifies only a five-digit Postal or ZIP code as a stop,
the trip will be routed to Mexico in cases where there are duplicate codes
between the US and Mexico.

Use default US and Mexican Zip Code: The default U.S. ZIP code or
Mexican postal code will be returned. If there are U.S. and Mexican
codes with the same number, the default U.S. ZIP code will be returned.
If there is only a Mexican postal code for that number, the default
Mexican code will be returned.
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The default for this setting can be changed in the PCMSERVE.INI file (see
Appendix D). If they are not already there, these lines can be added to the
[OPTIONS] section. The possible setting combinations are:

e UseUSPostCodes=False and UseMexPostCodes=False — Defaults to
the U.S. ZIP with no routing to Mexican postal codes

e UseUSPostCodes=True and UseMexPostCodes=False — Same as
above

e UseUSPostCodes=True and UseMexPostCodes=True — Defaults to
the U.S. ZIP, must pass an Estados code to get Mexican location (e.g.
“50510,EM”)

e UseUSPostCodes=False and UseMexPostCodes=True — Only

Mexican postal codes are available, in the U.S. only city-state pairs will
get U.S. location (e.g. “Chico, CA”)

4.4 Configuring Estados Code for Nuevo Leon

By default the Province Code ‘NL’ is used for Newfoundland and Labrador and the
Estados Code ‘NX’ is used for Nuevo Leon. To use ‘NL’ for Mexican locations,
click the Options dropdown menu and choose NL Abbreviation and highlight your
choice.
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5.0 Using PC*MILER for the AS400

To use PC*MILER for the AS400, issue the command PCMILER (or
PCMTLL for PC*MILER|Tolls) from the command line.

PCMILER Main Screen:

=] session & - [24x 80] - - O *

File Edit View Communication Actions Window Help

PCHiler 31.0

HS Request Type (MI - SM - HS)

Routing Type (P=Prac - 5=5Short) _ _

Hub or Optimize (H,R,F or Blank} (T - Blank) {H=Htnl 5=53ft Blank)
Borders - O{pen}) C{losed)

Custom Routing - C{ustom)-Blank

Ovrd Restrictions (Y or N) {Add-0n Products}

Miles or Kilometers (M or K) _ G,C,E,F,I or R

Use Ferry Distance (Y or NJ) N A,E,F,N,0,5 (Continent)

o

(]|

a=4=4

Enter City,State,County or Zip {Press Help key for examples)
Margo, VA, Spotsylwvania
25235 Chloe, WY, Calhoun

Debs, MHN, Beltrami

Kittys Corner, MD, Talbot
Andrew, FL, Leon

1
2
3
4
5
6
2
8
9

10
FZ2=5tate help F3=Exit Fi=Ins stop FB8=Del stop
F10=Process Fll=Restart F22=5wap stops FZ3=Load Trip F24=5av Trip

mMAJ A Ml 18/011

NOTE: The PCMILER or PCMTLL command contacts the mileage server
to read the data that the mileage server is using. If the command doesn’t
respond or the PC*MILER screen comes up with "PC DOWN?” in the
screen title, there is a problem with the connection to the mileage server
PC.



PC*MILER-AS400 User’s Guide 27

PCMTLL Main Screen:

2] Session A - [24x80] bt — O by

File Edit View Communication Actions Window Help
PCHMiler Tolls 31.0
S Request Type (MI - SHM - HS)
Routing Type (P=Prac - S5=5hort) 5 National/53Foot _ Toll Discouraged
Toll Cost {T=Cash - D{iscount) {(N=Ntnl 5=53ft Blank) (T or Blank)
Borders - O{(pen}) C{losed)
Use Ferry Distance (Y or N) {Add-0n Products}
Hub or Optimize (H,R,F or Blank}) HazMat . _ G,C,E,F,I or R
Miles or Kilometers (M or K) N A,E,F,N,0,5 (Continent)
Custom Routing (C=Custom or Blank)
Ovrd Rstrctions (Y or H)

s

IZIIZII<WW4W|

Enter City,State,County or Zip {Press Help key for examples)

Margo, VYA, Spotsylvania
25235 Chloe, WY, Calhoun

Debs, MHN, Beltrami
Kittys Corner, MD, Talbot

Andrew, FL, |l eon

1
2
3
4
5
6
T
8
9

10
FZ2=5tate help F3=Exit F7=Ins stop FB8=Del stop
F10=Process Fli=Restart F22=5Swap stops F23=Load Trip F24=5Sawv Trip

MAl A ML 037041

Control settings at the top of the main entry screen include the following:

Request Type: "MI", the default entry, will generate only point-to-point
mileage look-ups. "SM" will generate a summary of miles traveled through
each state, broken down by toll roads and free roads, in addition to the point-
to-point mileage. "HS" will generate detailed driving instructions, in addition
to the state mileage summary and point-to-point mileage look-up.

Routing Type: Either Practical or Shortest routing can now be combined
with other available PC*MILER routing options (Toll Discouraged, National
Network, or 53' Trailer or Twins). You must specify either P (Practical) or S
(Shortest) for all routes. (Refer to the main PC*MILER User’s Guide for more
detailed descriptions of these routing options.) See Chapter 6, Using
PC*MILER With Other Transportation Software for details on using this
functionality with other software packages.

NOTE: Beginning in Version 30, the 53 Foot Trailer routing option has
been replaced with the ‘State + National Network’ routing option to better
reflect the combination in previous versions of PC*MILER’s National
Network and 53 Foot Trailer Networks when the 53 Foot Trailer option
was selected. The interactive green screen PC*MILER program has not
been updated to reflect the change. Choosing either the 53 Foot Trailer or
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National Network Extended Routing option will turn on the State + National
Network option.

Tolls Cost: (Only with PC*MILER|Tolls installed) “T” will generate the Cash
cost of all tolls incurred on a trip. “D” will give the Discounted toll cost. See
Appendix H, Setting Toll Discount Program Membership, for instructions on
configuring your discount memberships. Depending on the request type
used, you will get total toll costs for the entire trip, a state-by-state
breakdown of toll costs, or the toll cost per leg of the trip.

NOTE: PC*MILER|Tolls calculates tolls for an 80,000 pound, 5-axle
vehicle. Reported toll amounts are accurate and up-to-date, but not
always exact due to two factors: first, several — though not many — toll
roads have rates that are based on weight (for example, the Detroit-
Windsor Tunnel charges $.03 per 100 Ibs. gross weight in both directions);
and second, some toll charges (in various states) are time-of-day driven.
In the latter case, tolls will always be calculated using the highest rate.

Toll Discouraged: "T" will generate miles which avoid long stretches of toll
roads. You will receive either a Practical Toll Discouraged Route, or a
Shortest Toll Discouraged Route depending on how you have your “Routing
Type” set. Note that not all toll roads will be avoided; tolls are avoided where
possible while still maintaining a reasonable and practical route.

National/53 Foot: Either "N" or “5” will generate miles calculated using the
State + National Network which favors the US Federally designated National
Network (primary Interstates with reasonable entry/egress points up to 1 mile
off the Interstate) and state designated extensions to the National Network
(additional highways and supporting roads any distance off the Interstate, as
determined by individual states). State + National Network (National Network
or 53 Foot Trailer or Twins) will be generated using either the “Practical” or
“Shortest” routing type. You can also combine State + National Network
(National Network and 53 Foot Trailer or Twins) routing with the Toll
Discouraged option. For example you can generate a “Practical/Toll
Discouraged/National Network” route. See Chapter 6, Using PC*MILER
With Other Transportation Software for details on using this functionality
with other software packages.

Custom Routing: “C” will use custom routing preferences (avoids and
favors) set in PC*MILER or PC*MILER|Streets. When this position is blank,
routing preferences will be disabled.

Hub or Optimize: A blank space is the default entry and is used for
standard PC*MILER routing. “H” is used to generate hub distances. "R" is
used to initiate route sequencing with the origin fixed and the remaining
stops reordered. "F"is used to initiate route sequencing with both the origin
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and destination fixed and the remaining stops reordered. These options are
described in more detail in the main PC*MILER User's Guide.

Borders: “O” will open the borders and routes will cross International
Borders to obtain the most efficient trip. “C” will close the borders and routes
will only cross international borders if the trip has a stop in that country.

Ovrd (Override) Restrictions: In addition to the five basic PC*MILER
route types, a Heavy and Light Vehicle routing option is now offered. When
Ovrd Restrictions is set to “Y”, the Light Vehicle option is activated. With
Light Vehicle routing active, truck-prohibited roads will always be avoided,
but truck-restricted roads are considered for a route. (PC*MILER normally
gives preference to Interstates, major highways, and major thru-roads
where possible.)

NOTE: With Ovrd Restrictions set to “N”, Heavy Vehicle routing is in
effect, so both truck-prohibited and truck-restricted roads will be
avoided. In addition, Heavy Vehicle routing takes nationwide 13' 6"
height restrictions into account. A heavy vehicle is one weighing at least
80,000 pounds; a light vehicle weighs less than 80,000 pounds.

Miles/Kilometers: "M" will generate distances in miles. "K" will generate
distances in kilometers.

Use Ferry Distance: If set to “Y”, distance traveled on ferries will be
included in all distance totals. If set to “N” ferry distances are not included
in totals. Note: Routes will still include ferry travel but this travel is not
included in distance totals.

HazMat (Hazardous Material Type): (only with the PC*MILER|HazMat
add-on data module installed) Types of hazardous material routing that can
be generated are: “G” for General, “C” for Corrosive, “E” for explosive, “F”
for Flammable, “I” for Inhalant, and “R” for Radioactive.

Region (Continent): Regions in which mileage can be generated are: “A”
for Asia; “E” for Europe; “F” for Africa; “N” for North America; “O” for
Oceania; or “S” for South America. (Regions outside North America require
PC*MILER|Worldwide.)

FOR AN ON-SCREEN DISPLAY OF THESE DEFINITIONS, press the
Help key on your keyboard. For Terminal Emulation sessions on PC's,
this is typically the Scroll Lock key or Right Mouse Click > Help.

In the middle of the screen are the stop entry fields. Enter the city names
and state abbreviations for the stop-off locations desired, their ZIP codes,
or their latitude/longitude positions. Both the Spelling Helper and ZIP Code
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Helper described in the main PC*MILER User's Guide are available for use
with PC*MILER-AS400. You may enter up to 30 stop-offs.

NOTE for PC*MILER|Streets Users: An address should directly follow
the city/state or ZIP code entry, separated by a semicolon (e.g. “Princeton,
NJ; 457 North Harrison Street”).

You can also purchase separate add-on data modules for Canadian postal
codes or SPLC codes.

A Canadian postal code is entered in the same manner as a ZIP code, but
in the following format: L#L#L# or L#L<space> #L#. (e.g. “"K7L 4E7"). A
SPLC is a six- or nine-digit number, preceded by the letters ‘SPLC’ (e.g.
“SPLC908601").
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5.1 Function Keys

At the bottom of the screen, the function keys used with PC*MILER for the
AS400 are described. These include:

F2
F3
F7

F8

F10

F11

F12

F22

F23

F24

Help

State help. Displays a list of all state and province abbreviations.
Exit. Exits the program and returns to the main AS400 screen.

Ins stop. Allows you to insert a new stop-off where the cursor is
positioned.

Del stop. Allows you to delete a stop-off where the cursor is
positioned.

Process request. Sends the request to PC*MILER on the dedicated
PC.

Restart. Clears the screen, and lets you start making data entries
on the screen again.

Main Screen. Returns to the main stop entry screen from the
mileage report screens.

Reverse. Reverses the order of stops entered.

Load a saved trip. In the screen that comes up, typing "X" (with the
cursor on a trip identifier in the pick list) will load that trip; typing "D"
will delete the trip.

Save a trip. Enter a trip identifier of up to 10 characters in the entry
field that appears.

Pressing the key labeled “Help” on your keyboard will bring up
detailed instructions for using various features of PC*MILER for the
AS400. If you are using an emulator, the Help key on your keyboard
will usually be the Scroll Lock key or Right Mouse Click > Help.
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5.2 Basic Mileage, Cost and Time Report

Once you have entered stops on the main screen and initiated a mileage
inquiry by pressing <F10>, the following basic mileage screen will appear:

2] Session A - [24x80] had - O *

File Edit View Communication Actions Window Help
PCHMiler 31.0 _B/02/17
05:33:54

F3=Exit F9=Print
Fl1i=Restart F12=Main Scrn
AR A ML) 01/072

With PC*MILER | Tolls Installed:

2] Session A - [24x80] had - O *

File Edit View Communication Actions Window Help
PCHMiler Tolls 31.0 _B/02/17
05:17:23

F3=Exit FA=5tate Miles FB8=Directions F9=Print
Fl1i=Restart F12=Main Scrn F15=5awve Route

WA A MU 01/072




PC*MILER-AS400 User’s Guide

33

This basic PC*MILER mileage report contains leg and cumulative miles for
each segment of your trip. The time and cost estimates are based on the
values set in the copy of PC*MILER (or PC*MILER|Streets) installed on
your dedicated PC. (Refer to the main PC*MILER User's Guide for
instructions on how to alter these values.)

NOTE: The leg costs and total cost in the “COST” column include toll
costs if PC*MILER|Tolls is installed.

<F3> will exit the program. <F9> will print the screen. <F11> will return
you to the previous screen and will clear it. <F12> will return you to the
previous screen, without clearing it.
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5.3 State Mileage Report

After you enter stops on the main screen and initiate a state mileage request
(SM) by pressing <F10>, the basic mileage screen will appear:

2] Session A - [24 % 80] b — O x

File Edit View Communication Actions Window Help
PCHiler 31.0 _6/02/717
05:34:24

F3=Exit FA=5tate Hiles F9=Print
Fli=Restart F12=Main Scrn

HMAj A ML 01/072

With PC*MILER|Tolls Installed (costs in the “COST” column include tolls):

2] Session A - [24x 80] hd - O *

File Edit View Cemmunication Actions Window Help
PCMiler Tolls 31.0 _B/O2/17
05:18:12

F3=Exit FA=5tate Hiles F9=Print
F11=Restart F12Z2=Main 5Scrn

MAl A ML) 01/072
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Pressing <F4> displays Jurisdiction-by-Jurisdiction distance breakdowns:

2] Session A - [24 % 80] - — O x

File Edit View Communication Actions Window Help
PCHiler 31.0 6/02/17
State Mileage Summary 05:34:55

F9=Print
Fli=Restart F12=Main Scrn
AR 3] ML) 06/002

With PC*MILER | Tolls Installed:

2] Session A - [24x80] had - O *

Eile Edit Miew Communication Actions Window Help
PCHiler Tolls 31.0 6/02/17
State Mileage Summary 05:18:41

F9=Print

Fll1=Restart F1Z2=Main 5crn
Hﬂl A ML 06/002
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5.4 Detailed Driving Directions Report

After entering stops on the main screen and pressing <F10> to initiate a
Detailed Driving Directions (HS) request, press <F8> in the mileage report
screen to generate the driving directions. When processing is complete,
the screen shown below will appear. Note that driving directions take
significantly longer to process than miles or state miles because more
information is requested and returned.

] Secsion A - [24x 80] i — O by

File Edit View Communication Actions Window Help
PCHMiler 31.0 6502717
05:35:34

4 S5tops,. 3752 Hiles

F3=Exit FA=5tate HMiles F7=Miles F9=Print
Fl11=Restart F12=Main 5Scrn F15=5ave Route

HMAJY A ML 067002
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A Detailed Driving Directions report with PC*MILER|Tolls installed is
shown below. This sample report includes toll costs for each leg of the trip.

=] session & - [24x 80] - - O *

File Edit View Communication Actions Window Help
PCHiler Tolls 31.0 6/02/517
05:37:05

557
588
607
608
610
611
642
689
753
829
829
913
917
922
979

F3=Exit FA=5tate Hiles F9=Print
Fl11=Restart F12=Main 5Scrn F15=5ave Route

HAJ A ML 067002
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6.0 Using PC*MILER with other Transportation Software

NOTE for Version 21 and Higher: The following features are not
supported in the AS400 product line: Estimated Greenhouse Gas
Emissions, RouteSync, TripDirect, Entry/Exit Toll Plaza Names in Reports,
and Real-time/Historical Traffic Data. Province/Estado Abbreviation
Option to set “NL” preference is supported in Version 25-31 only.

Added to Version 20 and higher: Borders Open/Closed and Use Ferry
Distance options. The first two characters of the four-character “Request
Sequence” have been remapped to hold the Borders and Ferry Flags.

Historically the Request Sequence values have been ignored by the PC
Distance Server. Unlike other trip options, Border and Ferry settings are not
echoed back in the responses from the PC.

For the optional PC*MILER|HazMat hazardous material routing package,
two routing types have been added: Caustic and Flammable.

REMINDER: Users of PC*MILER Versions 14 and 15, and
PC*MILER|Streets Versions 1, 2000, 3, and 4 must type a comma
between the city and the state or province. For Version 16 and
higher you have the option of using a comma or a space between the
city and state or province abbreviation.

NOTE: PC*MILER 18 and higher has full Mexican Estado information.
Previously, all Mexican cities were referenced with ‘MX’ as the Estado
code and the Estado was returned in the US county field. For example:

Older versions format: Mexico City, MX, Distrito Federal
Correct format for Version 18: Mexico City, DF

Estados Codes:

AG Aguascalientes

BJ Baja California

BS Baja California Sur
CP  Campeche

CH  Chiapas

Cl Chihuahua

CU Coahuila de Zaragoza
CL Colima

DF  Distrito Federal

DG Durango
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GJ Guanajuato

GR  Guerrero

HG Hidalgo

JA  Jalisco

EM  Mexico (Estado)

MH  Michoacan de Ocampo

MR  Morelos

NA  Nayarit

New for 25=> NX* or NL Nuevo Leon (PC Side Configuration Option —
Tools menu)

OA Oaxaca

PU  Puebla

QA  Queretaro Arteaga
QR  Quintana Roo
SL  San Luis Potosi

SI Sinaloa
SO Sonora
TA Tabasco

TM  Tamaulipas
TL Tlaxcala
VZ Veracruz
YC  Yucatan

ZT Zacatecas

* “NX” is used for Nuevo Leon because “NL” is already used in the database for
the Canadian province of Newfoundland and Labrador. The option to configure
NL for routing to Nuevo Leon is supported in Version 25-31 only.

ALSO NOTE: For Version 17 and higher the routing type options have
changed for National Network, Toll Discouraged, and 53'/102" Trailer
routing. These three routing options now can be generated in combination
with the ‘Practical’ or ‘Shortest’ options. Additionally, National Network or
53' Trailer routing can be combined with the Toll Discouraged option. The
only way to take advantage of this functionality is to pass in the new code
in position 1 of the Request Options.

ALSO NOTE: Beginning in Version 30, the 53 Foot Trailer routing option
has been replaced with the ‘State + National Network’ routing option to
better reflect the combination in previous versions of PC*MILER’s National
Network and 53 Foot Trailer Networks when the 53 Foot Trailer option
was selected. For Third Party applications, ALK will continue to support
the use of either the ‘N’ or ‘5’ Network Types to turn on State + National
Network Routing. The following extended routing types will also turn on
State + National Routing portion of the request:
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C = National Network/Practical

D = 53 Foot Trailer/Practical

E = Toll Discouraged/National Network/Practical
F = Toll Discouraged/53 Foot Trailer/Practical

H = National Network/Shortest

| = 53 Foot Trailer/Shortest

J = Toll Discouraged/National Network/Shortest
K = Toll Discouraged/53 Foot Trailer/Shortest

Previously the five available codes were:
P = Practical

S = Shortest

N = National Network

T = Toll Discouraged

5 =53 Foot Trailer

New Codes:
P = Practical
S = Shortest

B = Toll Discouraged/Practical

C = National Network/Practical

D = 53 Foot Trailer/Practical

E = Toll Discouraged/National Network/Practical
F = Toll Discouraged/53 Foot Trailer/Practical

G = Toll Discouraged/Shortest

H = National Network/Shortest

| =53 Foot Trailer/Shortest

J = Toll Discouraged/National Network/Shortest
K = Toll Discouraged/53 Foot Trailer/Shortest

Use of the old codes is still supported, no changes are required. Old
codes for National Network (N), Toll Discouraged (T), and 53 Foot Trailer
(5) will be generated using the Practical network. Changing this default to
the Shortest network is not possible.

NOTE: For users upgrading from PC*MILER|Streets, the Light/Heavy
vehicle option has been renamed to ‘Override Restrictions’. Parameter
codes have changed from L (Light) to Y (Override Restrictions) and H
(Heavy) to N (Obey Restrictions). Use of L and H is still supported.

NOTE: For Version 16 and higher, the HS (Turn-by-Turn Driving
Instructions) return packet was changed from previous versions. The fields
for Route and Interchange were lengthened and the number of sets of
route information was reduced from 4 sets per packet to 3. See section
6.2.4 for details.
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6.1 Technical Overview

The PC*MILER-AS400 system uses distributed processing techniques (i.e.
the processing is split into two). The user interface or interactive software
is written in RPG and runs on the AS400. Small CL programs are used for
the creation and removal of temporary data queues (output or response
gueues). The mileage calculation software is written in C++ and runs on a
PC in the Windows environment.

The RPG programs communicate with the PC mileage calculation software
through Client Access Express. The interactive software on the AS400
allows multiple users to look up point-to-point mileage and routes for up to
thirty stop-off points. The Windows server application creates a data queue
on the AS400 at startup called MIDQUE. The server application waits for
mileage requests and processes them when received. While the server
application is waiting for work to do, the PC can be used for other tasks
such as PC*MILER graphics or RUMBA terminal emulation.

AS400 Programs

Files Description

MIINQ Main AS400 inquiry program that sends request to MIDQUE data queue

CITALK RPG program that verifies city ZIP spelling

CRTQ CL program that creates an output data queue based on the job number

DELQ CL program that deletes the queue created by CRTQ

GETLAT Sample RPG Program that converts City, Jurisdiction pairs or zip codes
to Lat/longs

GETLATC CL program that creates output queue and starts GETLAT RPG

GETMIL Sample RPG Program performs point-to-point mileage lookups
GETMILC CL program that creates output queue and starts GETMIL RPG

GETQNAME RPG Program that determines library and data queue name for sending requests
VALDR RPG Program that validates ZIP codes, place names, and street
addresses; also provides pick lists of ZIP codes, names and addresses
when partial name, ZIP or address is passed in RPG parameters.

MIDQUE Data queue that contains input mileage lookup records

MIINQC CL program that creates output data queue and starts MIINQ rpg

QUEUE CL program that writes to the MIDQUE request data queue

MISEND External data structure for sending mileage requests

MIRESP External data structure for receiving mileage output

DRAW External data structure for sending graphics requests to PC

MISEND2 External data structure with field mappings for Borders and Use Ferry Distance

TLSEND2 External data structure with field mappings for Borders and Use Ferry Distance
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The program MIINQ contains two subroutines that can be used to integrate
miles with other transportation software. The subroutine SNDREQ sends
mileage requests to PC*MILER and the subroutine RSLT receives mileage
results from PC*MILER. The subroutine PLOT can be used to send graphics
requests for ETA truck display of graphics. For example, a truck or vehicle ID’s
Lat/Long, ZIP, or city name position can be sent to the PC using PLOT and the
“DT” request. Then a “DR” request with the truck’s origin and destination can
be sent so that a graphical ETA can be determined. The data structures of
these subroutines are described below.

The PC Mileage Server can respond to a total of thirteen types of mileage
and graphic requests:

Mileage:

VN = Version of PC*MILER Highway Data being used by the server

VA = Validation that a stop (City, ZIP code, etc.) is recognized by
PC*MILER or a list of possible matches to a partial city or ZIP code

MI = Total mileage for up to 30 stops

SM = Total mileage for up to 30 stops broken down by state or province

HS = Turn-by-turn driving instructions for up to 30 stops

LL = Returns the lat/long coordinates for a city or address
(PC*MILER|Streets only)

Graphics:

DR = Draw Route for up to 30 Stops

DT = Draw up to 30 truck bitmaps or “push pins” on the map
CT = Clear Truck bitmap from a specified location

CR = Clear a drawn route line

CA = Clear all routes and trucks

PR = Print route

PA = Printall

The PC Mileage Server responds with the following types of returns:
VR — Version of PC*MILER or PC*MILER|Streets running on the PC
PL — Good/Bad Stop or a ‘pick list’ of potential matches

CP — Total Miles for a trip

SR — Total Miles for a trip broken down by state or province

HR — Turn-by-turn driving instructions or “highway segments”

VN  returns a VR

VA  returns a PL

MI returns a CP

SM  returns a CP and an SR.

HS returns a CP, an SR and an HR

LL returns an LR
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6.2 Request and Response Field Parameters

The following sections specify the field parameters for the request types
defined in section 6.1 and the responses to each request type.

IMPORTANT NOTE: When using PC*MILER|Streets, the best matching
for address location lookups can be accomplished using the guidelines
stated below. These rules apply to batch or interactive integration. It is
recommended that a validation (VA) request always precede each
mileage request, especially where street addresses are included, in
order to avoid misleading or incomplete output.

When you input a street address, use a city and state abbreviation
whenever possible:

Example: Princeton, NJ;1000 Herrontown Road — The comma between
the city and state is optional. The semicolon between the state
abbreviation and the street address is required. Use a street number.

Example: Princeton, NJ;1000 Herrontown Road as opposed to
“Princeton, NJ;Herrontown Road”. In this example, if Herrontown Road is
50 miles long and no address is included, the returned mileage could be
very inaccurate.

When a street address is not supplied, do not send a semicolon:

Example: Send 08540 as opposed to “08540;” — a semicolon will cause
the server to look up a blank address (unnecessary).

Three examples of correct input:
Trenton, NJ;21 Olden Avenue
New York, NY;118 Broadway
20001
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6.2.1 Stop Validation (VA) Request and Response

The following are field parameters for stop and (for PC*MILER|Streets
users) street address validation. A stop can be a city/state pair separated
by a comma, a ZIP code, a latitude/longitude point or (with optional add-on
modules) a Canadian Postal code or SPLC (Standard Position Location
Codes). PC*MILER|Streets users may include street addresses.

For Cities with multiple ZIP codes, the first city in the returned list is the
central city or default ZIP for that city, with the remaining ZIP codes returned
in numeric order.

When generating potential matches for an address, PC*MILER|Streets
does a “Grid Based” search. This means that the search area may extend
beyond the city limits of the requested city for potential matches. You may
receive back potential matches in a surrounding town. Pick lists are sorted
in confidence order, with the “best” potential match returned first.

For example:
Requesting a pick list by setting REQ-CIT equal to Princeton,NJ;Linden*
would return the following list:

08540 Princeton, NJ, Mercer; 1 Linden Lane
08540 Princeton, NJ, Mercer; 49 Linden Lane
08540 Princeton, NJ, Mercer; 80 Linden Lane
08540 Princeton, NJ, Mercer; 100 Linden Lane
08534 Pennington, NJ, Mercer; Linden & Woodmer
08534 Pennington, NJ, Mercer; Linden & Woodmer
08822 Flemington, NJ, Mercer; 1 Linden Court
08822 Flemington, NJ, Mercer; 1 Linden Court
08536 Plainsboro, NJ, Mercer; 2 Linden Lane
08536 Plainsboro, NJ, Mercer; 3 Linden Lane
08536 Plainsboro, NJ, Mercer; 4 Linden Lane

NOTE: Grid Based searches are only done with address level lookups
(PC*MILER|Streets only).

Validation requests are important because error reporting in mileage
requests is limited to the first two stops of a trip. If your bad stop is lower in
the list of stops, you will not be told which is the non-valid stop; you will get
a generic “Can’t Run Trip” message. The VA request type can be used to
produce lists of potential matches to partial spellings or ZIP codes.



PC*MILER-AS400 User’s Guide

45

Validation Request:

Var Name
REQ-TYPE
REQ-REF

Filler 6
REGION
(Worldwide Only)

Filler 1
Force Pick List

Filler 7
REQ-CIT

Filler-CIT

Len

10

630

Validation Response:

Var Name

REQ-TYPE
REQ-REF
Filler-3
RESP-MORE
Filler 2
REGION
Match

Force Pick List
Filler-1

Len

PR NP WEN

Value
VA

Value
PL

Description Extended Format

Validate Stop or Address
Output Queue Name
(ALK uses “Q” plus job number)

Pos 19) A=Asia
E=Europe,
F=Africa
N=North America
O=0ceania
S=South America

Pos 21) P or Blank P=Force Pick List, or
use wildcard * after a partial
city or address

Pos 29) 70 bytes each left justified

38 byte maximum city name

1 byte comma (optional)

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)

or for PC*MILER|Streets

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use the format L#L<space>
#L# (add-on data module)

For Standard Position Location Codes SPLC plus
the number (add-on data module)

blank

Description Extended Format

Stop pick list

Output Queue Name

3 blanks

Pos 16) M = more data to follow
2 blanks

Pos 19) Echoed from Request
Pos 20)

List of Cities

Exact match

No match

Pos 21) Echoed from Request P or Blank
1 blanks
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RESP-Seq
RESP-ERR

RESP-CIT

Filler

N B~

980

15

E2

Pos 23-26) Sequence for multiple responses
Pos 27-28 Error Code

Place not found

Array of 14 places 70 bytes each left justified
or

Error message if there is a problem

6.2.2 Point-to-point Miles (MI) Request and Response

1. (Request) The following are field parameters for requesting miles. The
purpose of the Mileage request is to allow the host application to retrieve
point-to-point miles. This type of request could be used for a quick mile
lookup from a host inquire program or for running several stop-off points in
a batch environment. The host dispatching software could generate this

request when a new trip is established.

Var Name

REQ-TYPE
REQ-REF

Len

2
10

Trip Options Positions 13-22

REQ-OPTION

Network/Practical

Network/Practical

Network/Shortest

Shortest

REQ-MORE

REQ-FMT

1

A

Value
Ml

Description Extended Format

Miles request

Output Queue Name

(ALK uses ‘Q’ + the job number)
Request Position

Pos 1) S=Shortest
P=Practical
N=State + National Network
T=Toll Discouraged/Practical
5=State + National Network
B=Toll Discouraged/Practical
C=National Network/Practical
D=State + National Network/Practical
E=Toll Discouraged/State + National

F=Toll Discouraged/State + National

G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I=State + National Network/Shortest
J=Toll Discouraged/State + National

K=Toll Discouraged/State + National Network/

Pos2) M or K for miles or kilometers

Pos 3) R=resequence stops
H=hub leg miles
F=resequence stops fixed destination
blank=otherwise

Pos4) M=more data to follow

Pos5) Reserved by DR request

Pos 6) E =Extended Format
(Required, see Appendix A)
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REGION 1 Pos7) A=Asia
(Worldwide Only) E=Europe,
F=Africa
N=North America
O=0Oceania
S=South America
Custom Routing 1 Pos 8) C=Custom, blank=default
Override Restrictions 1 Pos9) Y=Override Restrictions, L=Light
N=Obey Restrictions or H=Heavy
Hazmat (Data Add-on) 1 Pos 10) G=General Restriction
C=Corrosive
E=Explosive Restriction
F=Flammable
I =Inhalant Restriction
R = Radioactive Restriction

REQ-BRDR 1 Pos 11) O=Borders Open C= Closed

REQ-FERRY 1 Pos 12) Y=Include Ferry Distance N=Do Not Include
Ferry Distance

REQ-SEQ 2 Sequence for multiple responses (Not read by PC)

REQ-ERR 2 Error Code

REQ-CIT 700 Array of 10 places 70 bytes each left justified

3 sets of 700 when using the more flag

38 byte maximum city name

1 byte comma

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)

or

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS
Warminster,PA;1174 NASSAU ROAD
18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use L#L<space> #L#
Standard Position Location Code use
SPLC+number

2. (Response) The following are field parameters for output miles. The City
Pair response returns an output to the host application that contains city
names and ZIP codes along with miles, cost and time estimates. The CP
response is always returned first for all three request types (MI, SM, and
HS).

Var Name Len Value Description Extended Format
RESP-TYPE 2 CP City pair returned output
RESP-REF 10 Output Queue Name

(ALK uses ‘Q’ + the job number)
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Request Options 13-22
RESP-NET 1 Pos 1) S=Shortest
P=Practical
N=State + National/Practical
T=Toll Discouraged/Practical
5=State + National Network/Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D=State + National Network/Practical
E=Toll Discouraged/State + National
Network/Practical
F=Toll Discouraged/ State + National Network

[Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I= State + National Network /Shortest
J=Toll Discouraged/State + National
Network/Shortest
K=Toll Discouraged/State + National
Network/Shortest
RESP-MIL-TYPE 1 Pos2) M or K for miles or kilometers
RESP-OPTION 1 Pos 3) R =resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
RESP-MORE 1 Pos4) M = more data to follow
Pos5) Reserved by DR request
1 Pos 6) E=Extended Format
REGION 1 Pos7) A=Asia, E=Europe, F=Africa, N=North
America, O=Oceania, S=South America
Custom Routing 1 Pos 8) C=Custom, blank=default
Override Restrictions 1 Pos9) Y=Override Restrictions, L=Light,
N=Obey Restrictions or H=Heavy
Hazmat 1 Pos 10) G=General Restriction
C= Corrosive
E=Explosive Restriction
F=Flammable
I =Inhalant Restriction
R=Radioactive Restriction
RESP-SEQ 4 Sequence for multiple responses (Note: Border & Ferry
settings not echoed in CP response.)
RESP-ERR 2 Error Code
El First state not found
E2 First city not found
E3 Second state not found
E4 Second city not found
E5 Unable to resequence
E6 Unable to calculate route
E9 Disconnected Highway Network
RESP-CIT1 39 39 bytes

All stop information including

Zip and\or city\state and\or county and\or
Street address

or

If there is error, the pcmiler error code
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RESP-CIT2 39 39 bytes
All stop information including
Zip and\or city\state and\or county and\or
Street address

RESP-MILE 5 Total miles returned or PC*MILER 3-digit error code
RESP-HOUR 4 Total time in hours (0031) = 3.1 hours

RESP-COST 7 Total cost for city pair (0052295) = 522.95

FILL133 133

0256 Blank

6.2.3 State Miles (SM) Request and Response

1. (Request) The following are field parameters for a state miles request.
The purpose of this request is to attain the state-by-state mileage
information associated with a trip.

Var Name Len Value Description Extended Format
REQ-TYPE 2 SM Miles request
REQ-REF 10 Output Queue Name

(ALK uses ‘Q’ + the job number)
Request Options 13-22
REQ-OPTION 1 Pos 1) S=Shortest
P=Practical
N=State + National Network/Practical
T=Toll Discouraged/Practical
5= State + National Network /Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D= State + National Network /Practical
E=Toll Discouraged/State + National
Network/Practical
F=Toll Discouraged/ State + National Network
[Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I= State + National Network /Shortest
J=Toll Discouraged/State + National
Network/Shortest
K=Toll Discouraged/ State + National Network /
Shortest
1 Pos2) M or K for miles or kilometers
1 Pos 3) R =resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
Pos4) M = more data to follow
Pos5) Reserved by DR request
REQ-FMT 1 Pos 6) E = Extended Format
(Required, see Appendix A)
REGION 1 Pos7) A=Asia
(Worldwide Only) E=Europe,
F=Africa
N=North America
O=0ceania

[EEN

REQ-MORE

[EEN
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S=South America
Custom Routing 1 Pos 8) C=Custom, blank=default

Override Restrictions 1 Pos9) Y=Override Restrictions or L=Light
N=Obey Restrictions or H=Heavy
Hazmat 1 Pos 10) G=General Restriction
C=Corrosive
E=Explosive Restriction
F=Flammable
I=Inhalant Restriction
R=Radioactive Restriction
REQ-BRDR 1 Pos11) O=Borders Open C= Closed
REQ-FERRY 1 Pos12) Y=Include Ferry Distance N=Do Not Include
Ferry Distance
REQ-SEQ 2 Sequence for multiple responses (Not read by PC)
REQ-ERR 2 Error Code
REQ-CIT 700 Array of 10 places 70 bytes each left justified

3 sets of 700 when using the more flag

38 byte maximum city name

1 byte comma

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)

or

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use the format L#L #L#

2. (Response) The following are field parameters for the state miles output.
The PC will respond with the miles (or kilometers) for the stops indicated in
the “SM” request. There will be 10 state miles returned for each record. If
additional records are needed, an “M” in the “MORE” parameters field is
used to indicate that there is more data to follow.

NOTES: A “CP” (city pair, point-to-point miles) response is always
returned first for all three request types (MI, SM, and HS), and an "SR"
(state miles) output record follows the “CP” response to an "HS" (highway
system, detailed route information) request (see section 6.2.4).

Response from PC Len Value Description
REQTYPE 2 SR State miles summary
REFNUM 10 Output Queue Name

(ALK uses ‘Q’ + the job number)
Request Options 13-22
PARAMS 1 Pos 1) S=Shortest
P=Practical
N=State + National/Practical
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T=Toll Discouraged/Practical
5= State + National Network /Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D= State + National Network /Practical
E=Toll Discouraged/State + National
Network/Practical
F=Toll Discouraged/ State + National Network
[Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I= State + National Network /Shortest
J=Toll Discouraged/State + National
Network/Shortest
K=Toll Discouraged/ State + National Network /
Shortest
1 Pos2) M or K for miles or kilometers
1 Pos 3) R =resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
REQ-MORE 1 Pos4) M = more data to follow
1 Pos5) Reserved by DR request
REQ-FMT 1 Pos 6) E = Extended Format
(Required, see Appendix A)
REGION 1 Pos 7) A=Asia, E=Europe, F=Africa, N=North
America, O=Oceania, S=South America
Custom Routing 1 Pos 8) C=Custom, blank=default
Override Restrictions 1 Pos9) Y=Override Restrictions, L=Light,
N=Obey Restrictions or H=Heavy
Hazmat 1 Pos 10) G=General Restriction
C=Corrosive
E=Explosive Restriction
F=Flammable
I =Inhalant Restriction
R=Radioactive Restriction
SEQNUM 4 Sequence for multiple responses (Note: Border & Ferry
settings not echoed in CP response.)

ERROR 2 Error Code

El First state not found

E2 First city not found

E3 Second state not found

E4 Second city not found

E5 Unable to resequence

E6 Unable to calculate route

E9 Disconnected Highway Network
STATEMIL 220 10 elements each element will consist of:

2 for state code

5 for total miles

4 for toll miles
FILLER 8
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6.2.4 Detailed Route Information (HS) Request and Response

1. (Request) Following are parameters for a route and state miles request.
The purpose of this request is to allow the Host to retrieve detailed route
information based on the city pair stop-off points.

Var Name Len Value Description Extended Format
REQ-TYPE 2 HS Miles request
REQ-REF 10 Output Queue Name

(ALK uses ‘Q’ + the job number)

Request Options 13-22
REQ-OPTION 1 Pos 1) S=Shortest
P=Practical
N=State + National/Practical
T=Toll Discouraged/Practical
5= State + National Network /Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D= State + National Network /Practical
E=Toll Discouraged/State + National
Network/Practical
F=Toll Discouraged/ State + National Network
[Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I= State + National Network /Shortest
J=Toll Discouraged/State + National
Network/Shortest
K=Toll Discouraged/ State + National Network /
Shortest
1 Pos2) M or K for miles or kilometers
1 Pos 3) R =resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
Pos4) M = more data to follow
Pos5) Reserved by DR request
REQ-FMT 1 Pos 6) E = Extended Format
(Required, see appendix A)
REGION 1 Pos 7) A=Asia, E=Europe, F=Africa, N=North
America, O=Oceania, S=South America
Custom Routing 1 Pos 8) C=Custom, blank=default
Override Restrictions 1 Pos9) Y=Override Restrictions, L=Light
N=Obey Restrictions or H=Heavy
Hazmat 1 Pos 10) G=General Restriction
C=Corrosive
E=Explosive Restriction
F=Flammable
I=Inhalant Restriction
R=Radioactive Restriction
REQ-BRDR 1 Pos1l) O=Borders Open C= Closed

REQ-MORE

e

REQ-FERRY 1 Pos12) Y=Include Ferry Distance N=Do Not Include
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Ferry Distance

REQ-SEQ 2 Sequence for multiple responses (Not read by PC)
REQ-ERR 2 Error Code
REQ-CIT 700 Array of 10 places 70 bytes each left justified

3 sets of 700 when using the more flag

38 byte maximum city name

1 byte comma

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)

or

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use the formal L#L #L#

2. (Response) Following are field parameters for a response to the route
and state miles request. The PC response record has all of the required
detailed route information. There are four route list records\response
records. Therefore, if there are more than four records for the route,
additional response records must be returned. Multiple returned records
are designated by the “M” in the “MORE” parameter field.

REMEMBER: A “CP” and “SR” output record will always precede the
“HR” response record.

Response from PC Len Value Description
REQTYPE 2 HR Route highway information returned
REFNUM 10 Output Queue Name

(ALK uses ‘Q’ + the job number)
Request Options 13-22
REQ-OPTION 1 Pos 1) S=Shortest
P=Practical
N=State + National/Practical
T=Toll Discouraged/Practical
5= State + National Network /Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D= State + National Network /Practical
E=Toll Discouraged/State + National
Network/Practical
F=Toll Discouraged/ State + National Network
[Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I= State + National Network /Shortest
J=Toll Discouraged/State + National
Network/Shortest
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1

1
REQ-MORE 1

1
REQ-FMT 1
REGION 1
Custom Routing 1
Override Restrictions 1
Hazmat 1
SEQNUM 4
ERROR 2

ROUTEINFO

3 sets

NOTES:

El
E2
E3
E4
E5
E9

K=Toll Discouraged/ State + National Network
/Shortest
Pos2) M or K for miles or kilometers
Pos 3) R =resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
Pos4) M = more data to follow
Pos5) Reserved by DR request
Pos6) E = Extended Format
(Required, see Appendix A)
Pos7) A=Asia, E=Europe, F=Africa, N=North
America, O=Oceania, S=South America
Pos 8) C=Custom, blank=default
Pos9) Y=Override Restrictions, L =Light,
N=Obey Restrictions or H=Heavy
Pos 10) G=General Restriction
C=Corrosive
E=Explosive Restriction
F=Flammable
I=Inhalant Restriction
R=Radioactive Restriction

Sequence for multiple responses
Note: Border & Ferry settings not echoed in CP response.

Error code

First state not found

First city not found

Second state not found

Second city not found

Unable to resequence
Disconnected Highway Network
2 indicates end of route data for stop
2 state code

1 toll indicator

6 directional (North, Turn L, etc)
35 route number

4 leg mileage

38 for intersection city or junction
6 for cumulative leg miles

6 for cumulative stop miles

The PC will send CP response records for MI requests.

The PC will send CP and SR response records for SM requests.
The PC will send CP, SR, and HR response records for HS requests
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6.2.5 Upgrade Notice

For Version 16 and higher, the ROUTEINFO portion of the HS return was
increased by 25 characters and the number of ROUTEINFO Sets per
response packet was decreased from four sets to three. Route Number
was increased 15 characters from 20 to 35 (Highway, Road or Street
Name), and Interchange City or Junction was increased 10 characters from

28 to 38.

The previous format is shown below.

Format in previous versions:

ROUTEINFO

4 sets —

2 indicates end of route data for stop
2 state code

1 toll indicator

6 directional (North, Turn L, etc)

20 route number

4 leg mileage

28 for intersection city or junction

8 for cumulative leg miles

6 for cumulative stop miles

6.2.6 City/Address to Lat/Long Coordinates (LL) Request and Response

1. (Request) Following are parameters for latitude/longitude coordinates for
a given city, postal code, or address (PC*MILER|Streets only). Lat/longs
are returned in degree, minute second format.

For example:
0394346N,0861610W

Var Name Len
REQ-TYPE 2
REFNUM 10
FILL-10 10
REQ-SEQ 4
REQ-ERR 2
REQ-CIT 70

Value

LL

Description Extended Format

Lat/Long
Output Queue Name
(ALK uses ‘Q’ + the job number)

Blank Fill

Sequence (Always 0001 for LL Requests)
Error Code

38 byte maximum city name

1 byte comma or space

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)
or
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1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use the formal L#L #L#

2. (Response) Following are parameters for a latitude longitude coordinate
response. Lat/longs are returned in degree, minute second format.

For example:
0394346N,0861610W

Var Name Len
REQ-TYPE 2
REFNUM 10
FILL-10 10
RESP-SEQ 4
RESP-ERR 2
RESP-LL 17

Fill-211 211

Value
LR

Description Extended Format

Lat/Long
Output Queue Name
(ALK uses ‘Q’ + the job number)

Blank Fill

Sequence (Always 0001 for LL Requests)
Error Code (E2=No Match Found)
Lat/Long Coordinate in

Degree, Minutes, Seconds Format

Blank Fill
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6.3 Sample Request and Response Records
Sample records are shown below.

Sample State Miles (SM) request record:

State Mile request type Extended Format (required) Origin city name and state

Region = North America abbreviation;

street address only with
PC*MILER|Streets

Output Queue Name
(“Q” plus job number)

y,

4

SMQ208684 PM EN Y CYO1 princeton,nj ;1000 herrontown road
san diego,caT

l Y = Override Restrictions (Light) l

Sequence # for multiple responses |

Practical routing | Report distances in Miles

Destination city name and
state abbreviation

Sample State Miles (SR) response record:

“M” for “More”
indicates more
than one SR
record needed,
record to follow

Total miles, total time, total cost — see Miles
(MI) request and response description

CP response record
precedes SR response

!

CPQ208684 PM M L 0001 Princeton, NJ;1000 Herrontown Road 92138 San
Diego, CA, San Dg€go 0279104250306987

SRQ208684 PM M N L 0002
AZOO4900000CA001690000ILOOl7200qglsi?1570000M0002860000NJ000160000NM003730

0000H0023300000K003550195PA00347
SRQ208684  PM N L 0003
TX00179$QOOWV000130000

State Miles: AZ, CA, IL, IN, etc.

More State Miles in second SR output
record: TX, WV
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7.0 Using PC*MILER]Tolls with Other Transportation
Software

Notes for Existing PC*MILER-AS400 Users:

» Asetof 10 new trip parameters has been inserted into all of the
request and response packets.

* Allreturn types (CP, SR, HR) were expanded to hold Toll Cost
information. CP was expanded by seven characters, SR by 77, and
HR by 63.

For PC*MILER|Tolls, the ROUTEINFO portion of the HS return was
increased by seven characters and the number of ROUTEINFO sets per
response packet was increased from three to nine to improve performance.
For users who are upgrading from Version 15 or less, see NOTE below for
previous changes.

* Output Data Queue sizes were lengthened from 1024 to 1048.

* Data Area “TLLALK” (renamed from COMALK) was modified to
store a default setting for toll cost requests.

e “Old mode” or short city names (22 characters) are not supported.

NOTE for Version 22-31: The following features are not supported in the
AS400 product line: Fuel Optimization, Vehicle Profiles, Estimated
Greenhouse Gas Emissions, RouteSync, TripDirect, Entry/Exit Toll Plaza
Names in Reports, and Real-time/Historical Traffic Data. Province/Estado
Abbreviation Option to set “NL” preference is supported in Version 25-31
only.

Added for Version 20 and higher: Borders Open/Closed and Use Ferry
Distance options. The first two characters of the four-character “Request
Sequence” have been re-mapped to hold the Borders and Ferry Flags.

Historically the Request Sequence values have been ignored by the PC
Distance Server. Unlike other trip options, Border and Ferry settings are not
echoed back in the responses from the PC.

For the optional PC*MILER|HazMat hazardous material routing package,
two routing types have been added: Caustic and Flammable.

NOTE: PC*MILER 18 and higher now has full Mexican Estado
information. Previously, all Mexican cities were referenced with ‘MX’ as
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the Estado code and the Estado was returned in the US county field. For
example:

Older versions format: Mexico City, MX, Distrito Federal
Correct format for Version 18: Mexico City, DF

REMINDER: The Province/Estado Abbreviation Option to set the “NL”
preference is supported only in Version 25-31.

Estados Codes:

AG  Aguascalientes

BJ Baja California

BS Baja California Sur
CP Campeche

CH Chiapas

Cl Chihuahua

Cu Coahuila de Zaragoza
CL Colima

DF Distrito Federal

DG Durango

GJ Guanajuato

GR Guerrero

HG Hidalgo

JA Jalisco

EM Mexico (Estado)

MH  Michoacan de Ocampo

MR Morelos
NA Nayarit
New for 25=>NX* or NL Nuevo Leon (PC Side Configuration Option — Tools menu)
OA Oaxaca
PU Puebla

QA Queretaro Arteaga
QR Quintana Roo
SL San Luis Potosi
Sl Sinaloa

SO Sonora

TA Tabasco

™ Tamaulipas

TL Tlaxcala

VZ Veracruz

YC Yucatan

ZT Zacatecas

“NX" is used for Nuevo Leon because “NL” is already used in the database for the
Canadian province of Newfoundland and Labrador. The option to configure NL for
routing to Nuevo Leon is supported in Version 25-31 only.
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NOTE: For Version 17 and higher the routing type options have changed
for National Network, Toll Discouraged, and 53'/102" Trailer routing.
These three routing options now can be generated in combination with the
‘Practical’ or ‘Shortest’ options. Additionally, National Network or 53'
Trailer routing can be combined with the Toll Discouraged option. The only
way to take advantage of this new functionality is to pass in the new code
in position 1 of the Request Options.

NOTE: Beginning in Version 30, the 53 Foot Trailer routing option has
been replaced with the ‘State + National Network’ routing option to better
reflect the combination in previous versions of PC*MILER’s National
Network and 53 Foot Trailer Networks when the 53 Foot Trailer option
was selected. For Third Party applications, ALK will continue to support
the use of either the ‘N’ or ‘5’ Network Types to turn on State + National
Network Routing. The following extended routing types will also turn on
State + National Routing portion of the request:

C = National Network/Practical

D = 53 Foot Trailer/Practical

E = Toll Discouraged/National Network/Practical
F = Toll Discouraged/53 Foot Trailer/Practical

H = National Network/Shortest

| = 53 Foot Trailer/Shortest

J = Toll Discouraged/National Network/Shortest
K = Toll Discouraged/53 Foot Trailer/Shortest

Previously the five available codes were:

P = Practical

S = Shortest

N = National Network
T = Toll Discouraged
5 =53 Foot Trailer

New Codes:
P = Practical
S = Shortest

B = Toll Discouraged/Practical
C = National Network/Practical
D =53 Foot Trailer/Practical
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E = Toll Discouraged/National Network/Practical
F = Toll Discouraged/53 Foot Trailer/Practical

G = Toll Discouraged/Shortest

H = National Network/Shortest

| =53 Foot Trailer/Shortest

J = Toll Discouraged/National Network/Shortest
K = Toll Discouraged/53 Foot Trailer/Shortest

Use of the old codes is still supported, no changes are required. Old codes
for National Network (N), Toll Discouraged (T), and 53 Foot Trailer (5) will
be generated using the Practical network. Changing this default to the
Shortest network is not possible.

NOTE: For users upgrading from PC*MILER|Streets, the Light/Heavy
vehicle option has been renamed to ‘Override Restrictions’. Parameter
codes have changed from L (Light) to Y (Override Restrictions) and H
(Heavy) to N (Obey Restrictions). Use of L and H is still supported.

NOTE: For Version 16 and higher, the HS (Turn-by-Turn Driving
Instructions) return packet was changed from previous versions. The fields
for Route and Interchange were lengthened and the number of sets of
route information was reduced from 4 sets per packet to 3. See section
7.2.4 for details.

REMINDER: For Version 16 and higher you have the option of using
a comma or a space between the city and state or province
abbreviation.
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7.1 Technical Overview

The PC*MILER for the AS400 system uses distributed processing
techniques (i.e. the processing is split into two). The user interface or
interactive software is written in RPG and runs on the AS400. Small CL
programs are used for the creation and removal of temporary data queues
(output or response queues). The mileage calculation software is written in
C++ and runs on a PC in the Windows environment.

The RPG programs communicate with the PC mileage calculation software
through Client Access Express. The interactive software on the AS400
allows multiple users to look up point-to-point mileages and routes for up to
thirty stop-off points. The Windows server application creates a data queue
on the AS400 at startup called MIDQUE. The server application waits for
mileage requests and processes them when received. While the server
application is waiting for work to do, the PC can be used for other tasks
such as PC*MILER graphics or terminal emulation.

AS400 Programs (see Appendix G for information on renamed objects)

Files Description

TOLLINQ Main AS400 inquiry program that sends request to MIDQUE data queue

TOLLINQC CL program that creates output queue and starts TOLLINQ rpg.

CITTLL RPG program that verifies city ZIP spelling

CRTQ CL program that creates an output data queue based on the job number

DELQ CL program that deletes the queue created by CRTQ

GTTLAT Sample RPG Program that converts City, Jurisdiction pairs or zip codes to
Lat/longs

GTTLATC CL program that creates output queue and starts GETLAT RPG

GTTMIL Sample RPG Program that performs point-to-point mileage lookups

GTTMILC CL program that creates output queue and starts GETMIL RPG

GTQONAMTL  RPG Program that determines library and data queue name for sending
requests

VTLADR RPG Program that validates ZIP codes, place names, and street
addresses; also provides pick lists of ZIPs codes, names and addresses
when partial name, ZIP or address is passed in RPG parameters.

MIDQUE Data queue that contains input mileage lookup records

QUEUE CL program that writes to the MIDQUE request data queue

TLSEND External data structure for sending mileage requests

TLRESP External data structure for receiving mileage output

TLDRW External data structure for sending graphics requests to PC

TLSEND2 External data structure with field mappings for Borders and Use Ferry Distance
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The program TOLLINQ contains two subroutines that can be used to integrate
miles with other transportation software. The subroutine SNDREQ sends
mileage requests to PC*MILER and the subroutine RSLT receives mileage
results from PC*MILER. The subroutine PLOT can be used to send graphics
requests for ETA truck display of graphics.

For example, a truck or vehicle ID’s Lat/Long, ZIP, or city name position can
be sent to the PC using PLOT and the “DT” request. Then a “DR” request with
the truck’s origin and destination can be sent so that a graphical ETA can be
determined. The data structures of these subroutines are described below.

The PC Mileage Server can respond to a total of thirteen types of mileage
and graphic requests:

Mileage:

VN = Version of PC*MILER being used by the server

VA = Validation that a stop (City, ZIP code, etc.) is recognized by
PC*MILER or a list of possible matches to a partial city or ZIP code

MI = Total mileage for up to 30 stops

SM = Total mileage for up to 30 stops broken down by state or province

HS = Turn-by-turn driving instructions for up to 30 stops

LL = Returns the lat/long coordinates for a city or address
(PC*MILER|Streets only)

Graphics:

DR = Draw Route for up to 30 Stops

DT = Draw up to 30 truck bitmaps or “push pins” on the map
CT = Clear Truck bitmap from a specified location

CR = Clear a drawn route line

CA = Clear all routes and trucks

PR = Print route

PA = Printall

The PC Mileage Server responds with the following types of returns:
VR — Version of PC*MILER running on the PC

PL — Good/Bad Stop or a ‘pick list’ of potential matches

CP — Total Miles for a trip

SR — Total Miles for a trip broken down by state or province
HR — Turn-by-turn driving instructions or “highway segments”
VN returns a VR

VA returns a PL

Ml returns a CP

SM returns a CP and an SR.

HS returns a CP, an SR and an HR

LL returnsan LR
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7.2 Request and Response Field Parameters

The following sections specify the field parameters for the request types
defined in section 7.1 and the responses to each request type.

IMPORTANT NOTE: When using PC*MILER|Streets, the best matching
for address location lookups can be accomplished using the guidelines
stated below. These rules apply to batch or interactive integration. It is
recommended that a validation (VA) request always precede each
mileage request, especially where street addresses are included, in
order to avoid misleading or incomplete output.

When you input a street address, use a city and state abbreviation
whenever possible:

Example: Princeton, NJ;1000 Herrontown Road — The comma between
the city and state is optional. The semicolon between the state
abbreviation and the street address is required. Use a street number.

Example: Princeton, NJ;1000 Herrontown Road as opposed to
“Princeton, NJ;Herrontown Road”. In this example, if Herrontown Road is
50 miles long and no address is included, the returned mileages could be
very inaccurate.

When a street address is not supplied, do not send a semicolon:

Example: Send 08540 as opposed to “08540;” — a semicolon will cause
the server to look up a blank address (unnecessary).

Three examples of correct input:
Trenton, NJ;21 Olden Avenue
New York, NY;118 Broadway
20001
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7.2.1 Stop Validation (VA) Request and Response

The following are field parameters for stop and (for PC*MILER|Streets
users) street address validation. A stop can be a city/state pair separated
by a comma, a ZIP code, a latitude/longitude point, or (with optional add-on
modules) a Canadian Postal Code or SPLC (Standard Position Location
Codes). PC*MILER|Streets users may include street addresses.

For cities with multiple ZIP codes, the first city in the returned list is the
central city or default ZIP for that city, with the remaining ZIP codes returned
in numeric order.

When generating potential matches for an address, PC*MILER|Streets
does a “Grid Based” search. This means that the search area may extend
beyond the city limits of the requested city for potential matches. You may
receive back potential matches in a surrounding town. Pick lists are sorted
in confidence order, with the “best” potential match returned first.

For example:
Requesting a pick list by setting REQ-CIT equal to Princeton,NJ;Linden*
would return the following list:

08540 Princeton, NJ, Mercer; 1 Linden Lane
08540 Princeton, NJ, Mercer; 49 Linden Lane
08540 Princeton, NJ, Mercer; 80 Linden Lane
08540 Princeton, NJ, Mercer; 100 Linden Lane
08534 Pennington, NJ, Mercer; Linden & Woodmer
08534 Pennington, NJ, Mercer; Linden & Woodmer
08822 Flemington, NJ, Mercer; 1 Linden Court
08822 Flemington, NJ, Mercer; 1 Linden Court
08536 Plainsboro, NJ, Mercer; 2 Linden Lane
08536 Plainsboro, NJ, Mercer; 3 Linden Lane
08536 Plainsboro, NJ, Mercer; 4 Linden Lane

NOTE: Grid Based searches are only done with address level lookups
(PC*MILER|Streets only).

Validation requests are important because error reporting in mileage
requests is limited to the first two stops of a trip. If your bad stop is lower in
the list of stops, you will not be told which is the non-valid stop, you will get
a generic “Can’t Run Trip” message. The VA request type can be used to
produce lists of potential matches to partial spellings or ZIP codes.

For PC*MILER|Tolls, the VA Request layouts and the PL Response layouts
were increased by 10 characters to hold a new set of trip parameters.
Output data queues increased from 1024 to 1048.
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Validation Request:

Var Name
REQ-TYPE
REQ-REF

Filler-8
Force Pick List

Filler-17
REQ-CIT

Len

10

17
70

Validation Response:

Var Name

REQ-TYPE
REQ-REF
Filler-3
RESP-MORE
Filler-3
Match

Force Pick List
Filler-1
RESP-Seq
RESP-ERR

Filler 10
RESP-CIT

Filler-16

Total 1035

Len

P WORFRPRWEDN

N B~

10
980

16

Value
VA

Value
PL

Zz<r

E2

Description

Validate Stop or Address
Output Queue Name
(ALK uses “Q” plus job number)

Extended Format

Pos 21)

P or Blank P=Force Pick List, or use wildcard *
after a partial city or address

Pos 22-38) blanks, previously 7 characters.

Pos 39)

70 bytes each left justified

38 byte maximum city name

1 byte comma (or optional space)

2 byte state abbrev

1 byte comma (or optional space)

13 byte county hame (optional)

or for PC*MILER|Streets

1 byte semicolon ; followed by street address

Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD 18974

Lat/long format should be 1234567N,1234567W

5 digit zips only

Canadian Postal Codes use the format L#L<space>

#L# (add-on data module)

For Standard Position Location Codes SPLC plus

the number (add-on data module)

Description Extended Format

Stop pick list

Output Queue Name

3 blanks

Pos 16) M = more data to follow

Pos 20)

List of Cities

Exact match

No match

Pos 21) Echoed from Request P or Blank

1 blank

Pos 23-26) Sequence for multiple responses
Pos 27-28 Error Code

Place not found

Pos 29-38)

Pos 39-1018)

Array of 15 places, 70 bytes each left justified
or

Error message if there is a problem

Pos 1019-1035
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7.2.2 Point-to-point Miles (MI) Request and Response

For PC*MILER|Tolls, the MI Request layout was increased by 10 to hold a
new set of trip parameters. The CP Response layout was increased by
these 10 new trip parameters plus 7 characters to hold Tolls Cost data.
Output data queues increased from 1024 to 1048.

1. (Request) The following are field parameters for requesting miles. The
purpose of the Mileage request is to allow the host application to retrieve
point-to-point miles. This type of request could be used for a quick mileage
lookup from a host inquire program or for running several stop-off points in
a batch environment. The host dispatching software could generate this

request when a new trip is established.

Var Name Len Value Description Extended Format
REQ-TYPE 2 Ml Miles request
REQ-REF 10 Output Queue Name
(ALK uses ‘Q’ + the job number)
Trip Options Positions ~ 13-22 Request Position
REQ-OPTION 1 Pos 1) S=Shortest
P=Practical

1 Pos 2)
1 Pos 3)
REQ-MORE 1 Pos 4)
1 Pos 5)
REQ-FMT 1 Pos 6)
REGION 1 Pos 7)

(Worldwide Only)

N=State + National/Practical

T=Toll Discouraged/Practical

5=State + National Network/Practical

B=Toll Discouraged/Practical

C=State + National Network/Practical

D=State + National Network/Practical

E=Toll Discouraged/State + National Network/Practical
F=Toll Discouraged/State + National Network/Practical
G=Toll Discouraged/Shortest

H= State + National Network/Shortest

I=State + National Network/Shortest

J=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
M or K for miles or kilometers

R=resequence stops

H=hub leg miles

F=resequence stops fixed destination

blank=otherwise

M=more data to follow
Reserved by DR request

E =Extended Format
(Required, see Appendix A)

A=Asia
E=Europe,
F=Africa
N=North America
O=0Oceania
S=South America
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Custom Routing 1
Override Restrictions 1
Hazmat (Data Add-on) 1
REQ-BRDR 1
REQ-FERRY 1
REQ-SEQ 2
REQ-ERR 2
More Trip Options
REQ-MVS 3
REQ-TollCost 1
REQ—Fill 6

REQ-CIT 700

Pos 8) C=Custom, blank=default

Pos9) Y=Override Restrictions, L=Light,
N=0bey Restrictions or H=Heavy

Pos 10) G = General Restriction
C=Corrosive
E=Explosive Restriction
F=Flammable
I=Inhalant Restriction
R=Radioactive Restriction

Pos11) O=Borders Open C= Closed

Pos12) Y=Include Ferry Distance N=Do Not
Include Ferry Distance

Sequence for multiple responses (Not read by PC)
Error Code

Pos 29-38)

Pos 1-3) MVS Version Only*

Pos 4) T for Cash D for Discount or Blank
Pos 5-10) Not used blank fill

Array of 10 places 70 bytes each left justified

3 sets of 700 when using the more flag

38 byte maximum city name

1 byte comma (or optional space)

2 byte state abbrev

1 byte comma (or optional space)

13 byte county name (optional)

or

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use L#L<space> #L#
Standard Position Location Code use SPLC+number

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for

connection to multiple versions of PC*MILER.
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2. (Response) The following are field parameters for output miles. The City
Pair response returns an output to the host application that contains city
names and ZIP codes along with miles, cost and time estimates. The CP
response is always returned first for all three request types (MI, SM, and

HS).

Var Name
RESP-TYPE
RESP-REF

Request Options
RESP-NET

RESP-MIL-TYPE
RESP-OPTION

RESP-MORE
REGION
Custom Routing

Override Restrictions

Hazmat

RESP-SEQ

RESP-ERR

Len Value

2 CP

10

13-22

1

1

1

1

1

1

1

1

1

4

2
El
E2
E3
E4
E5
E6

Description Extended Format
City pair returned output

Output Queue Name

(ALK uses ‘Q’ + the job number)

Pos 1) S=Shortest
P=Practical
N=State + National/Practical
T=Toll Discouraged/Practical
5=State + National Network/Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D=State + National Network/Practical
E=Toll Discouraged/State + National Network/Practical
F=Toll Discouraged/State + National Network/Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I=State + National Network/Shortest
J=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
M or K for miles or kilometers
R = resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
M = more data to follow
Pos5) Reserved by DR request
Pos 6) E=Extended Format
Pos7) A=Asia,E=Europe,F=Africa,N=North
America,0=0Oceania,S=South America
C=Custom, blank=default
Y=Override Restrictions or
L=Light
N=Obey Restrictions or H=Heavy
Pos 10) G = General Restriction
C=Corrosive
E = Explosive Restriction
F=Flammable
I = Inhalant Restriction
R = Radioactive Restriction
Sequence for multiple responses (Note: Border & Ferry
settings not echoed in CP response.)
Error Code
First state not found
First city not found
Second state not found
Second city not found
Unable to resequence
Unable to calculate route

Pos 2)
Pos 3)

Pos 4)

Pos 8)
Pos 9)
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E9 Disconnected Highway Network

More Options 29 -38 (Echoed Back From Request)
RESP-MVS 3 Pos 1-3) MVS Version Only*
RESP-TollCost 1 Pos 4) Tolls Cost
RESP-FILL 6 Post 5-10) Not Used
RESP-CIT1 39 39 bytes

All stop information including

Zip and\or city\state and\or county and\or

Street address

or

If there is error, the error code
RESP-CIT2 39 39 bytes

All stop information including

Zip and\or city\state and\or county and\or

Street address
RESP-MILE 5 Total miles returned or 3-digit error code
RESP-HOUR 4 Total time in hours (0031) = 3.1 hours
RESP-COST 7 Total cost for city pair (0052295) = 522.95
RESP-TollCost 7 Tolls Cost for city pair (0007920) = $79.20
FILL127 127 Blanks
Total 267

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for
connection to multiple versions of PC*MILER.

7.2.3 State Miles (SM) Request and Response

For PC*MILER|Tolls, the SM Request layouts were increased by 10 to hold
a new set of Trip Parameters. The SR Response Layouts were increased
by these 10 new trip parameters plus 70 characters (10 sets of 7) to hold
Tolls Cost data. Output Data Queues increased from 1024 to 1048.

1. (Request) The following are field parameters for a state miles request.
The purpose of this request is to attain the state-by-state mileage
information associated with a trip.

Var Name Len Value Description
REQ-TYPE 2 SM Miles request
REQ-REF 10 Output Queue Name

(ALK uses ‘Q’ + the job number)

Extended Format

Request Options 13-22
REQ-OPTION 1 Pos 1) S=Shortest
P=Practical
N=State +
National/Practical
T=Toll Discouraged/Practical
5=State + National Network/Practical
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REQ-MORE
REQ-FMT

REGION
(Worldwide Only)

Custom Routing
Override Restrictions

Hazmat

REQ-BRDR
REQ-FERRY

REQ-SEQ
REQ-ERR

More Trip Options
REQ-MVS
REQ-TollCost
REQ—Fill 6

REQ-CIT

B=Toll Discouraged/Practical
C=State + National Network/Practical
D=State + National Network/Practical
E=Toll Discouraged/State + National Network/Practical
F=Toll Discouraged/State + National Network/Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I=State + National Network/Shortest
J=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
Pos2) M or K for miles or kilometers
Pos 3) R =resequence stops
H = hub leg miles
F = resequence stops fixed destination
blank = otherwise
Pos4) M = more data to follow
Pos5) Reserved by DR request
Pos 6) E = Extended Format
(Required, see Appendix A)
Pos7) A=Asia
E=Europe,
F=Africa
N=North America
O=Oceania
S=South America
Pos 8) C=Custom, blank=default
Pos9) Y=Override Restrictions, L=Light,
N=Obey Restrictions or H=Heavy
Pos 10) G = General Restriction
C=Corrosive
E = Explosive Restriction
F=Flammable
| = Inhalant Restriction
R = Radioactive Restriction
Pos11) O=Borders Open C= Closed
Pos12) Y=Include Ferry Distance N=Do Not
Include Ferry Distance

Sequence for multiple responses (Not read by PC)
Error Code

Pos 29-38)

Pos 1-3) MVS Version Only*

Pos 4) T for Cash D for Discount or Blank

Pos 5-10) Not used blank fill

Array of 10 places 70 bytes each left justified
3 sets of 700 when using the more flag

38 byte maximum city name

1 byte comma

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)

or

1 byte semicolon ; followed by street address

Examples
Warminster,PA,BUCKS
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Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only
Canadian Postal Codes use the format L#L #L#

NOTE: REQ-SEQ is not read for SM requests.

REQ-BRDR and REQ-FERRY values are not echoed back in the PC responses.

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for

connection to multiple versions of PC*MILER.

2. (Response) The following are field parameters for the state miles output.
The PC will respond with the miles (or kilometers) for the stops indicated in
the "SM" request. There will be 10 state miles returned for each record. If
additional records are needed, an "M" in the "MORE" parameters field is
used to indicate that there is more data to follow.

NOTES: A “CP” (city pair, point-to-point miles) response is always
returned first for all three request types (MI, SM, and HS), and an "SR"
(state miles) output record follows the “CP” response to an "HS" (highway
system, detailed route information) request (see section 7.2.4).

Response from PC Len Value Description
REQTYPE 2 SR State miles summary
REFNUM 10 Output Queue Name

(ALK uses ‘Q’ + the job number)

Request Options 13-22

PARAMS 1 Pos 1) S=Shortest

1 Pos 2)
1 Pos 3)
REQ-MORE 1 Pos 4)
1 Pos 5)

REQ-FMT 1 Pos 6)

P=Practical

N=State + National/Practical

T=Toll Discouraged/Practical

5=State + National Network/Practical

B=Toll Discouraged/Practical

C=State + National Network/Practical

D=State + National Network/Practical

E=Toll Discouraged/State + National Network/Practical
F=Toll Discouraged/State + National Network/Practical
G=Toll Discouraged/Shortest

H=State + National Network/Shortest

I=State + National Network/Shortest

J=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
M or K for miles or kilometers

R = resequence stops

H = hub leg miles

F = resequence stops fixed destination

blank = otherwise

M = more data to follow

Reserved by DR request

E = Extended Format
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REGION 1
Custom Routing 1
Override Restrictions 1
Hazmat 1
SEQNUM 4
ERROR 2
More Options 29 -38
RESP-MVS 3
RESP-TollCost 1
RESP-FILL 6
STATEMIL 180

10 Sets
FILLER 48
Total 267

El
E2
E3
E4
E5
E6
E9

(Required, see Appendix A)
A=Asia,E=Europe,F=Africa,N=North
America,0=0Oceania,S=South America
C=Custom, blank=default
Y=Override Restrictions, L=Light,
N=Obey Restrictions or H=Heavy
Pos 10) G = General Restriction
C=Corrosive
E = Explosive Restriction
F=Flammable
| = Inhalant Restriction
R = Radioactive Restriction
Sequence for multiple responses (Note: Border & Ferry
settings not echoed in CP response.)
Error Code
First state not found
First city not found
Second state not found
Second city not found
Unable to resequence
Unable to calculate route
Disconnected Highway Network
(Echoed Back From Request)
Pos 1-3) MVS Version Only
Pos 4) Tolls Cost
Post 5-10) Not Used

Pos 7)

Pos 8)
Pos 9)

10 elements, each element will consist of:
2 for state code

5 for total miles

4 for toll miles

7 for Tolls Costs

Blanks

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for

connection to multiple versions of PC*MILER.
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7.2.4 Detailed Route Information (HS) Request and Response

For PC*MILER|Tolls, the HS Request layouts were increased by 10 to hold
a new set of Trip Parameters. The HR Response Layouts were changed in
two ways: The number of Sets of Route Information was increased from
three to nine to improve performance. This route information was increased
by 63 to hold Tolls Cost data (7 x 9 sets). Output Data Queues increased
from 1024 to 1048.

1. (Request) Following are parameters for a route and state miles request.
The purpose of this request is to allow the Host to retrieve detailed route
information based on the city pair stop-off points.

Var Name Len Value Description Extended Format
REQ-TYPE 2 HS Miles request
REQ-REF 10 Output Queue Name

(ALK uses ‘Q’ + the job number)

Request Options 13-22

REQ-OPTION 1 Pos 1) S=Shortest
P=Practical

N=State + National/Practical
T=Toll Discouraged/Practical
5=State + National Network/Practical
B=Toll Discouraged/Practical
C=State + National Network/Practical
D=State + National Network/Practical
E=Toll Discouraged/State + National Network/Practical
F=Toll Discouraged/State + National Network/Practical
G=Toll Discouraged/Shortest
H=State + National Network/Shortest
I=State + National Network/Shortest
J=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
1 Pos2) M or K for miles or kilometers
1 Pos 3) R =resequence stops

H = hub leg miles
F = resequence stops fixed destination
blank = otherwise

REQ-MORE 1 Pos4) M = more data to follow
1 Pos5) Reserved by DR request

REQ-FMT 1 Pos 6) E = Extended Format
(Required see appendix A)

REGION 1 Pos 7) A=Asia, E=Europe, F=Africa, N=North
America, O=0ceania, S=South America

Custom Routing 1 Pos 8) C=Custom, blank=default

Override Restrictions 1 Pos9) Y=Override Restrictions or L=Light

N=0Obey Restrictions or H=Heavy
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Hazmat 1 Pos 10) G = General Restriction
C=Corrosive
E = Explosive Restriction
F=Flammable
I = Inhalant Restriction
R = Radioactive Restriction

REQ-BRDR 1 Pos11) O=Borders Open C= Closed (not
echoed back)

REQ-FERRY 1 Pos12) Y=Include Ferry Distance N=Do Not
Include Ferry Distance (not echoed back)

REQ-SEQ 2 Sequence for multiple responses (Not read by PC)

REQ-ERR 2 Error Code

More Trip Options 10 Positions 29-38)

REQ-MVS 3 Pos 1-3) MVS Version Only*

REQ-TollCost 1 Pos 4) T for Cash D for Discount or Blank

REQ—Fill 6 Pos 5-10) Not used blank fill

REQ-CIT 700 Array of 10 places 70 bytes each left justified

3 sets of 700 when using the more flag

38 byte maximum city name

1 byte comma (or space)

2 byte state abbrev

1 byte comma (or space)

13 byte county hame (optional)

or

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS

Warminster,PA;1174 NASSAU ROAD

18974

Lat/long format should be 1234567N,1234567W
5 digit zips only

Canadian Postal Codes use the formal L#L #L#

NOTE: REQ-SEQ is not read for HS requests.
REQ-BRDR and REQ-FERRY values are not echoed back in the PC responses.

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for
connection to multiple versions of PC*MILER.
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2. (Response) Following are field parameters for a response to the route
and state miles request. The PC response record has all of the required

detailed route information.

There are four route list records\response

records. Therefore, if there are more than nine records for the route,
additional response records must be returned. Multiple returned records
are designated by the "M" in the "MORE" parameter field.

REMEMBER: A “CP” and “SR” output record will always precede the
“HR” response record.

Response from PC

REQTYPE
REFNUM

Request Options
REQ-OPTION

REQ-MORE
REQ-FMT
REGION

Custom Routing
Override Restrictions

Hazmat

SEQNUM
ERROR

Len Value

2 HR
10

13-22

e

Description

Route highway information returned
Output Queue Name
(ALK uses ‘Q’ + the job number)

Pos 1)

Pos 2)
Pos 3)

Pos 4)
Pos 5)
Pos 6)
Pos 7)

Pos 8)
Pos 9)

Pos 10)

S=Shortest

P=Practical

N=State + National/Practical

T=Toll Discouraged/Practical

5=State + National Network/Practical

B=Toll Discouraged/Practical

C=State + National Network/Practical

D=State + National Network/Practical

E=Toll Discouraged/State + National Network/Practical
F=Toll Discouraged/State + National Network/Practical
G=Toll Discouraged/Shortest

H= State + National Network/Shortest

I=State + National Network/Shortest

J=Toll Discouraged/State + National Network/Shortest
K=Toll Discouraged/State + National Network/Shortest
M or K for miles or kilometers

R = resequence stops

H = hub leg miles

F = resequence stops fixed destination

blank = otherwise

M = more data to follow

Reserved by DR request

E = Extended Format

(Required see appendix A)
A=Asia,E=Europe,F=Africa,N=North
America,0=0Oceania,S=South America

C=Custom, blank=default

Y=Override Restrictions, L=Light,

N=0Obey Restrictions or H=Heavy

G = General Restriction

C=Corrosive

E = Explosive Restriction

F = Flammable

I = Inhalant Restriction

R = Radioactive Restriction

Sequence for multiple responses
Error code
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El First state not found
E2 First city not found

E3 Second state not found
E4 Second city not found
E5 Unable to resequence

E9 Disconnected Highway Network
E9 Disconnected Highway Network

More Options 29 -38 (Echoed Back From Request)
RESP-MVS 3 Pos 1-3) MVS Version Only*
RESP-TollCost 1 Pos 4) Tolls Cost
RESP-FILL 6 Post 5-10) Not Used

Number of Sets increased from 3 to 9, 7 characters added to each set to hold Tolls Cost Data
ROUTEINFO [ 2 indicates end of route data for stop

2 state code

1 toll indicator

NEW-> 9sets — 6 directional (North, Turn L, etc)

35 route number

4 leg mileage

38 for intersection city or junction

6 for cumulative leg miles

6 for cumulative stop miles

NEW-> | 7 for Tolls Cost on specific Leg
Fill-34 34
Total 1035
NOTES: The PC will send CP response records for M1 requests.

The PC will send CP and SR response records for SM requests.
The PC will send CP, SR, and HR response records for HS requests

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for
connection to multiple versions of PC*MILER.
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7.2.5 Upgrade Notice

For Version 16 and higher the ROUTEINFO portion of the HS return was
increased by 25 characters and the number of ROUTEINFO Sets per
response packet was decreased from four sets to three. Route Number
was increased 15 characters from 20 to 35 (Highway, Road or Street
Name), and Interchange City or Junction was increased 10 characters from

28 to 38.

The previous format is shown below.

Format in previous non-tolls versions:

ROUTEINFO

2 indicates end of route data for stop
2 state code

1 toll indicator

4 sets — 6 directional (North, Turn L, etc)

20 route number

4 leg mileage

28 for intersection city or junction

8 for cumulative leg miles

6 for cumulative stop miles

Format in PC*MILER|Tolls versions:

ROUTEINFO

2 indicates end of route data for stop
2 state code
1 toll indicator

NEW-> 9 sets — 6 directional (North, Turn L, etc)

35 route number

4 leg mileage

38 for intersection city or junction
6 for cumulative leg miles

| 6 for cumulative stop miles
NEW-> 7 for Tolls Cost on specific Leg
NEW-> Fill-34 34
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7.2.6 City/Address to Lat/Long (LL) Request and Response

1. (Request) Following are parameters for latitude/longitude coordinates for
a given city, postal code, or address (PC*MILER|Streets only). Lat/longs
are returned in degree, minute second format.

For example:

0394346N,0861610W

Var Name Len Value Description Extended Format
REQ-TYPE 2 LL Lat/Long
REFNUM 10 Output Queue Name

(ALK uses ‘Q’ + the job number)
FILL-10 10 Blank Fill
REQ-SEQ 4 Sequence (Always 0001 for LL Requests)
REQ-ERR 2 Error Code
More Trip Options 10 Positions 29-38)
REQ-MVS 3 Pos 1-3) MVS Version Only
REQ-TollCost 1 Pos 4) Not Used LL Request Type
REQ—Fill 6 Pos 5-10) Not used blank fill
REQ-CIT 70 38 byte maximum city name

1 byte comma or space

2 byte state abbrev

1 byte comma (optional)

13 byte county name (optional)

or

1 byte semicolon ; followed by street address
Examples

Warminster,PA,BUCKS
Warminster,PA;1174 NASSAU ROAD
18974

Lat/long format should be 1234567N,1234567W

5 digit zips only

Canadian Postal Codes use the formal L#L #L#

1. (Response) Following are parameters for a latitude longitude coordinate
response. Lat/longs are returned in degree, minute second format.

For example:
0394346N,0861610W

Var Name Len Value Description Extended Format
REQ-TYPE 2 LR Lat/Long
REFNUM 10 Output Queue Name

(ALK uses ‘Q’ + the job number)
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FILL-10 10
RESP-SEQ 4
RESP-ERR 2
More Options 29 -38
RESP-MVS 3
RESP-TollCost 1
RESP-FILL 6
RESP-LL 17
Fill-211 211

Blank Fill
Sequence (Always 0001 for LL Requests)
Error Code (E2=No Match Found)

(Echoed Back From Request)
Pos 1-3) MVS Version Only*
Pos 4) Not Used LL Requests
Post 5-10) Not Used

Lat/Long Coordinate in
Degree, Minutes, Seconds Format
Blank Fill

* “MVS” is the PC*MILER Multi Version Switch product, an optional product that allows for

connection to multiple versions of PC*MILER.

7.2.7 Optional: PC Server Version (VN) Request and Response

Used to check the version of PC*MILER software running on the Server PC.

Version Request:

Var Name Len
REQ-TYPE 2
REQ-REF 10

Version Response:

Var Name Len
RESP-TYPE 2
RESP-REF 10
Filler- 26 26
RESP-Ver 20
Filler-209 209

Total =267

Description Extended Format

Version of PC Software Running
Output Queue Name
(ALK uses “Q” plus job number

Description Extended Format

Stop pick list

Output Queue Name

Pos 13) blanks

Pos 39) Version/Type PC Software
Pos 59) blanks
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7.2.8 Sample Request and Response Records

Sample records are shown below.

Sample State Miles (SM) request record:

Extended Format (required)
Region = North America

State Mile request type

Output Queue Name
(“Q” plus job number)

Origin city name and state
abbreviation;
street address only with

Y = Override Restrictions (Light)

y,

PC*MILER|Streets

l

T=Cash Tolls Cost D=Discount

4

—

SMQ208684 PM EN Y CYO1 T princeton,nj ;1000 herrontown road
san diego,caT
Sequence # for multiple responses
Practical routing | Report distances in Miles

Destination city name and
state abbreviation

Sample State Mil

es (SR) response record:

CP response record
precedes SR response

Total Tolls Cost in Cents ($79.80)

“M” for “More”

indicates more
than one SR

record needed,

record to follow

Total miles, total time, total cost — see Miles
(MI) request and response description

l

CPQ208684 PM M L
Diego, CA, San Djégo
SRQ208684 PM M N L

AZ0049000000000000CAO
8600000000000NJ0001600
50000000PA003470

SRQ2086$4 PM N L

0001 Princeton, NJ311000 Herront
02791042503069870007980

Road 92138 San
0002
69000000000001L00172000000000001N0015700000003945M0002
000000NMO0373000000040350H00233000000000000K0P355019

0003TX0Q1790000WV000130000

Tolls Cost $40.35 in New

record: TX, WV

More State Miles in second SR output

Mexico $39.45 in Indiana

State Miles: AZ, CA, IL, IN,
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8.0 Menus

All menu commands in PC*MILER for the AS400 are described on the
following pages.

The File Menu

Using the File menu, you can open, close, save and duplicate routes; print
graphics and reports; and exit the PC*MILER program.

Delete AS400 Input Queue When a queue becomes corrupted,
creates a new queue and deletes the
corrupted one.

Exit Exit PC*MILER-AS400. When you
exit, all active windows are saved as
they appear on your screen for the
next time PC*MILER-AS400 is
opened.

AS400 Control Configure the Mileage server for
different purposes. Choose from the
sub-menu:

Change Library/Queue: Location of
request/input queue. Default Library
is ALKWIN or ALKTLL for
PC*MILER|Tolls. Default Data Queue
Name is MIDQUE. Innovative users,
use your ICC work library, i.e.
ITRS6WORK or IESR7WORK. If you
want to display routes/trucks for
requests coming from this one PC
rather than for all requests, use your
AS400 display name instead of
MIDQUE.

Mapping on: Turn mapping on or off.
Turning off mapping can speed up
batch applications.
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Graphics for Mile Requests: Turn
mapping on or off. The routes will not
be drawn on the map. This will speed
up the display.

Log to File: Turn diagnostics on/off.
This is useful for debugging problems.
When on, diagnostics are written to a
file called as400.log, located in the
directory that the software is running
from (srv32.exe). Choose between
Append, Overwrite, and Close.

Host Polling Timer: Use faster time
slice to poll the AS400 more often for
faster interactive response time, or
slower time slice for smoother graphic
display.

Force Pick List: Turns AS400 pick
lists off/on for duplicate city names.
Activates lists for both large cities with
multiple ZIP codes and duplicate city
names.

The Window Menu

Use the Window menu to control and organize the active windows in your

display.

Tile Vertical

Active windows will fit your screen,
running vertically.

Tile Horizontal

Active windows will fit your screen,
running horizontally.

Display Serve Log

Restore the Serve Log window if
minimized.
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9.0 Common Questions and Installation Problems

Question:

Answer:

Question:

Answer:

Question:

Answer:

PC*MILER works correctly when using the PCMILER command
on the AS400, but my Innovative software does not work.

Run the CONFIG command on the AS400 (which is described
in the manual) and type the Innovative work library name
193WORK, ITSR5WORK, or IESR7WORK (check with ICC).
After this is complete, check the File menu in the AS400
Mileage Server, choose AS400 Control>Change Library
Queue. Or you can edit the PCMSERVE.INI or PMWSSRV.INI
for PC*MILER|Streets, changing the LIBRARY=ALKWIN to
LIBRARY=I93WORK and then restart the AS400 Mileage
Server. Or re-install the AS400 windows CD and type
[93WORK. Restart the SERVER.

The Interactive PC*MILER screen crashes when | type in an
ICC Short City Code.

PC*MILER does a lookup in an ICC Cities database when you
use Short City Codes, a component program of PC*MILER
needs to be compiled with access to your Cities database. The
compile will fail unless you have ALKWIN and your Innovative
work and file libraries in your library list. Get a 400 command
line and do a DSPLIB, make sure you have ALKWIN and your
two Innovative Libraries in your list. The Innovative libraries are
different from release to release. They can be 193WORK and
[93DATA, or ITSRAWORK and ITSR4FILE, or ITSR5WORK
and ITSR5FILE, or ITSR6WORK and ITSR6FILE, or
IESR7WORK and IESR7FILE. If the necessary libraries are not
in your list use the ADDLIBLE command to add them. Then do
a WRKOBJPDM<space>ALKWIN. Do a 12 on QRPGSRC and
then a 14 on CITICC, say yes to replace existing member.

PC*MILER works correctly but my Innovative Print Missing
Tariff miles is not returning miles for a few cities.

The city spellings in the Innovative city file are different than in
PC*MILER. Use the report from the Print Missing Tariff Miles
(which lists the city discrepancies) and type PCMILER from the
AS400 command line. Now type the city code in, e.g. OCOK
(should be Oklahoma City OK) and press <ENTER>.
PC*MILER will indicate that it is not found. Now use the long
spelling of the city, for example ok* OK, to determine the
PC*MILER spelling. Press <F16> to invoke the ICC city update
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Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:
Answer:

program and correct the spelling for Oklahoma City OK. After
all the corrections are made, re-run the ICC Print Missing Tariff
Miles utility to update those missing miles.

Some of the mileage returned from PC*MILER is different from
the mileage returned by my other transportation software.

The city spelling or ZIP being used by the other software is
probably not correct. To verify what place name is being sent
to PC*MILER, click on the Pick Pins icon and then on the stop-
off point in the mapping window. Now correct your AS400 cities
file.

When | change my queue name to "MIDQUE", my PC can't
receive anything from the AS400.

Make sure that you exit and restart the PC*MILER interactive
software on the AS400. The PC*MILER program on the AS400
will detect the presence of the new queue and it will send
requests to this queue.

The interactive response time has become slower on the AS400
since we have added several more users. Can we improve the
performance?

Yes. You can run multiple copies of the PC*MILER-AS400
program on the same PC if you have enough memory. Or if you

have another available PC, you can start up PC*MILER-AS400
on the other PC.

How can | run PC*MILER-AS400 on more than one PC?

Make sure that PC*MILER-AS400 is installed properly on each
PC. Additionally, set the queue name to MIDQUE so that the
multiple PC's are servicing the same queue.
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10.0 Technical Support

Technical support is available to registered users of PC*MILER-AS400 from
8:00am to 5:00pm EST, Monday through Friday. Call (609) 683-0220,
ext. 2. Or, e-mail us at pcmsupport@alk.com (type “PCM/AS400” in the
subject line).



PC*MILER-AS400 User’s Guide 87

11.0 About ALK® Technologies

ALK Technologies is a transportation technology company dedicated to defining
the optimal route to success through innovative routing, mileage, mapping and
mobile navigation solutions. From trusted industry standard data to seamless
integration, ALK solutions are developed for a broad range of industries,
workforces, and everyday drivers on the road. For over 35 years, its suite of
powerful solutions, including PC*MILER®, CoPilot®, and ALK® Maps™, have set
the foundation for safe and efficient journeys worldwide — one mile, one driver, one
vehicle at a time. ALK is a Trimble (NASDAQ: TRMB) Company and part of its
international Transportation and Logistics Division.

Visit us at
www.alk.com

ATRIMELE COMPANY

A Transportation Technology Pioneer

since 1979 with millions of customers around the world.

Global Offices: USA, UK, France, Germarny, India

ROUTING =» MILEAGE = MAPPING = NAVIGATION


http://www.alk.com/
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Appendix A: Backward Compatibility

ALK Technologies does support backward compatibility with previous
versions of PC*MILER and PC*MILER for the AS400. However, it is not
advisable to develop new applications that use these short city name
structures, because you lose access to county information which is
necessary for resolving duplicate city name problems. Over time, this
backward compatibility becomes increasingly difficult for ALK Technologies
to maintain. Future backward compatibility is not guaranteed.

If you would like more information about backward-compatible formats,
please contact the ALK technical support staff (see Chapter 9).
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Appendix B: Configuring Client Access Express To

1.

Work With PC*MILER-AS400

Install Client Access Express on your mileage server PC by running the
setup.exe that is in the Express folder on your Client Access Express CD.

Go to the AS400 Operations Navigator. For new installations, a Navigator
prompt will ask if you want to add a connection. You will need to know the
IP Address of your AS400 and the System Name if you want to configure
your connection using the AS400 System name. You will have to make a
table entry in the PC’s Hosts File.

Here we are adding an AS400 called S102BWAM, you can also use the
IP address of your AS400.

Add AS5/7400 Connection - Welcome

“Welcome to the Operations Mavigator Add Connection
wizard.

What i the name of the 45 /400 syztem to which pou
want bo connect’?

ASA00 spsten:

E nvironment: by A5 /400 Connectionz j

< Blach I Heut » I Cancel
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For existing installations of Client Access Express, go into the AS400
Operations Navigator and right mouse click on your AS400 connection.
Choose Properties to make changes or Verify to verify a connection.

S102bwam Properties EH |

General | Licensesl Hestartl F'Iug-insl

—A5A400 zignan information

" UszeWindows user name and passward, no prompting

Ishumaker

% Usze default uzer ID, prampt az needed

IF'EMILEH

" Prompt every tims

— Security
N Use Secure Sockets Laver (S51

— Performance
IF address lookup frequency: IF address:
I.-'l'n.lways j I
Wwhere to lookup remote port:
IServer j

Mate: These values are used az defaultz by ather applications connecting from this PC
to thiz AS /400 spstem.

ak. I Cancel Help

The Connection Properties Window is used for changing existing
connections or changing the Restart Settings for new connections.

NOTE: Client Access Express has the ability to change passwords in the
user profile. If you are prompted for a new password, you will be making a
permanent change in that user profile.
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3. Password Considerations - There are several areas to consider with a
Client Access Express installation. Client Access Express offers three
Password options. You can choose to have the PC logged on manually to
the AS400, have Client Access Express use the Windows User Name and
Password, or you can specify a user profile and have the password typed
in as needed.

Add AS/7400 Connection - A5 /400 Signon Information [ x|

‘What uzer ID do you want to use ta sign on to 'ST02BWAM'?

" Lse ‘Windows user name and passward, no prompting

|SHUM.&KEH

& Usze default user ID. prompt as needed

PCMILER

€ Prompt every time

< Back I Mext > I Cancel

The default user ID is the User Profile that the mileage server PC will be
signing on to. This user will need the authority to create and delete data
gueues in either the ALKWIN Library or your Innovative Work Library.

If you choose to use the Windows User and Password, you have to have
the Windows User Name and Password match the user profile and
Password that you will be using for your mileage server PC to sign onto the
400 with. The Windows User and password must exactly match those in
the user profile you are using.

In the event of a power loss, the PC will not connect to the AS400 until
someone manually types in the Windows password. To get a PC to restart
without prompting for a password, you have to set the Windows Password
to nothing. AS400 security does not allow a null password. So if you want
the mileage server PC to reconnect automatically after a power outage, you
cannot use the Windows Password option.
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If you want to have an unattended restart, your only option with Client
Access Express is to store the User Profile Name and Password in the
mileage server’s .ini file. At this time, the password is not encrypted, but it

is stored as text.

5102bwam Properties |

Type of restart;

Auflonar
W auto-restart after power Failure
[T Remote power-on and restart

[T Scheduled restart

| Plug-inz I

I [Inattended

Drate: I

Time: I

If conzole problem ocours:
& Continue restart unattended

" End restart

o |

Cancel

Help

For auto-restart, you will also have to make the above settings in the
Connection Properties dialog. (For new connections, right mouse click on
your connection in the AS400 Operation Navigator, and choose properties

to get this screen.)
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4. Verify the connection. If a connection cannot be made, contact IBM for
assistance.

Verify AS/400 Connection ]|

Werifying 85 /400 connection:

Statug:

(3} Verifying conmection to system 5102BWak. .

-- Succezsfully connected to zerver application: Central Client

-- A} Successfully connected to server application; Metwork, File

-- (i) Successfully connected to server application: Metwark, Print

-- (i) Successfully connected to server application: Data Access

-- (i) Successfully connected to server application: Data Queuss
-- Succezsfully connected to server application: Bemote Command
-- Successfully connected ta server application: Security

#-(3) Successfully connected to server application: Telnet

----- (i) Connection verified to system 5102EWw

0k [Eanee] Yernfiatio [EfAE
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Appendix C: The Sleep Feature For PC Connection/
IPL Issues

The Sleep Feature has been added to correct an issue in which the PC
Distance Server (srv32.exe) does not reliably reconnect to the AS400 after
an IPL or power down.

To activate the Sleep Feature, you need to send a message to the PC
mileage server (SRV32.exe).

Included in your ALKWIN Library is a CL program called “queue”. For
gueue to work you must have alkwin in your library list. You may have to
compile the queue if you do not have the program — use the command
WRKOBJPDM, with 12 on QCLSRC and 14 on queue.

The syntax for queue is:

Queue<space>('SP60’)

where 60 is the number of seconds that you want the mileage server to
sleep for. (NOTE: Queue is case sensitive; the SP has to be in caps.)

To put the mileage server to sleep for a 3-hour period before an IPL, you
would have to run this command (with ALKWIN in your library list):

Call alkwin/queue<space>('SP10800’)

You will need to test the Sleep Feature. On your mileage server, set up
your screen so you can watch the mileage server's Server Log
(SRV32.exe).

To bring up the Server Log, click on the Bart's Windows pull-down menu, or
press ALT-W and choose Display server Log.

From a green screen, run PC*MILER and run a route from 10001 to 90009
to make sure that it is working. Watch the PC*MILER-AS400 Server’'s
server log. You should see those ZIP codes show up in a line that starts
out “input=...” This test is to ensure that you are working with the correct
mileage server, and that it is working properly.

Now exit the green screen PC*MILER and send a 60-second sleep
command:
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Call queue<space>(‘SP60’) press <ENTER>.

Watch the server log to see that it catches the sleep message. Finally, the
mileage server should wake up and reconnect with the mileage server.

Now go back to the green screen PC*MILER and send another mileage
request to test that the re-established connection is working properly. If it
is working now, you can use this feature before your ipl's or power downs.

You can use the Work with Job Schedule Entries (WRKJOBSCDE)
command to set up an automatic process.

Be sure to put it to sleep for a long enough period of time. If Bart (srv32.exe)
wakes up too early (before the AS400 is back up) it won’t be able to connect.
Be sure to leave enough time between sending the sleep command and
starting the ipl or power down.
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Appendix D: PCMSERVE.INI Settings

The pcmserve.ini file resides on the mileage PC in the c:\windows or the
c:\winnt folder. Values specified in pcmserve.ini will be used unless they
are otherwise specified in the mileage request packet. PC*MILER|Streets
uses pmwssrv.ini, and has a few additional key values included at the
bottom of the chart.

Valid values for default and option settings in the pcmserve.ini that can be
changed by the user are described below.

Key Valid Values Description
(Defaults)

[Defaults]

CalcType= Practical Not supported by

PC*MILER| AS400. If
routing type is not specifed
the default route type of
Practical will be used.

Units= Miles What unit of measure
Kilometers should distance be shown
in.
ChangeDest= TRUE When optimizing the route,
FALSE should the trip’s destination
be optimized also.
Borders= TRUE Should the engine try to
FALSE keep routes within the
United States (F), or can
they cross and recross the
borders at will (T).
HubMode= TRUE Calculate the routes from the
FALSE origin to each stop (T), not
through each stop (F).
AlphaOrder= TRUE List the states in the State
FALSE Report in alphabetical order,
or in the order driven.
FerryMiles= TRUE Use ferry distances in
FALSE mileage and cost calculations

(T), or don't use (F).
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[Options]

CustomRoute=

HazRoute=
(for PC*MILER
Hazmat add-on

only)

Light Vehicle=

PartialCityMatch=

UseUSPostCodes=

UseMexPostCodes=

TRUE
FALSE

None
General
Explosive
Inhalant
Radioactive
Corrosive
Flammable

TRUE
FALSE

TRUE
FALSE

TRUE
FALSE

Should Custom routing be
used.

The default hazardous
routing type: disabled,
general material, explosive,
inhalant, radioactive,
corrosive, or flammable.

Set to TRUE (T) for light
vehicle routing and
restriction overrides; FALSE
(F) = heavy vehicle routing
and obey restrictions.

Require exact match on city
name strings (T) or match on
partial city names (F).
Primarily used for long city
names like “Naval Shipyard
Portsmouth N0O018, VA,
Portsmouth”.

When set to TRUE, if a 5-
digit postal code might be a
U.S. or a Mexican code, the
U.S. code will be used. See
section 4.3 for all
UseUSPostCodes and
UseMexPostCodes setting
combinations.

Default = True

When set to TRUE, if a 5-
digit postal code might be a
U.S. or a Mexican code, the
Mexican code will be used.

Default = False

NOTE: If UseUSPostCodes
and UseMexPostCodes are
both FALSE, or are not in
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the INI, the default U.S.
code will be used. See
section 4.3 for a list of all
setting combinations.

PC*MILER|Streets-specific Key values for pmwssrv.ini:

[Options]

UseStreets= TRUE
FALSE

MatchRoadNameOnly= TRUE
FALSE

Should street-level (T) or
highway-only (F) routing be
used when stops are city
names or ZIP codes.

Set to (T) to match address on
road name only.
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Appendix E: AS400.LOG Error Codes

To create a log file of all mileage server input and outputs, click on the
mileage server’s File menu>AS400 Control and choose Log to file. The

file created is

c:\ALK  Technologies\pcmiler31\as400\as400.log.

AS400.log displays requests and responses in the exact format as they are
received and sent by the mileage server. It is recommended that logging
only be used for diagnostic purposes, as the log files get quite large.

PC*MILER Error Codes:

Error Codes

PCMS_INVALIDPTR
PCMS_NOINIFILE
PCMS_LOADINIFILE
PCMS_LOADGEOCODE
PCMS_LOADNETWORK
PCMS_MAXTRIPS
PCMS_INVALIDTRIP
PCMS_INVALIDSERVER
PCMS_BADROOTDIR

PCMS_BADMETANETDIR
PCMS_NOLICENSE

PCMS_TRIPNOTREADY
PCMS_INVALIDPLACE

PCMS_ROUTINGERROR
PCMS_OPTERROR

PCMS_OPTHUB
PCMS_OPT2STOPS
PCMS_OPT3STOPS

PCMS_NOTENOUGHSTOPS
PCMS_BADNETDIR
PCMS_LOADGRIDNET
PCMS_BADOPTIONDIR
PCMS_DISCONNECTEDNET
PCMS_NOTRUCKSTOP
PCMS_INVALIDREGIONID
PCMS_CLOSINGERROR

Value

101
102
103
104
105
106
107
108
109

110
111

112
113

114
115

116
117
118

119
120
121
122
123
124
125
126

Message

Invalid pointer

The INI file was not found

Could not load the INI file

Could not load location database
Could not load the network database
Too many open trips (limit of 8)
Invalid trip 1D

Invalid server ID

Could not find RootDir setting in INI
file

Invalid PCMNetDir setting

License infraction: too many users,
or licenses not found

The trip is not ready to calculate
Invalid place name (city, state not
found)

Calculation failed: portions of trip are
invalid

Optimization failed: portions of the
trip are invalid

Cannot optimize a trip in HUB mode
Not enough stops to optimize the trip
Not enough stops to optimize without
changing destination

Not enough stops to calculate the trip
Bad network directory

Error loading gridded network

Bad option directory

Disconnected network

Truck inaccessible stop

Invalid region ID

Server did not shut down

properly
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PCMS_NORTENGINE

PCMS_NODATASERVER

127

128

PC*MILER|Streets Error Codes:

Error Codes

PCMS_INVALIDPTR
PCMS_NOINIFILE
PCMS_LOADINIFILE
PCMS_LOADGEOCODE
PCMS_LOADNETWORK
PCMS_MAXTRIPS
PCMS_INVALIDTRIP
PCMS_INVALIDSERVER
PCMS_BADROOTDIR
PCMS_BADMETANETDIR
PCMS_NOLICENSE

PCMS_TRIPNOTREADY
PCMS_INVALIDPLACE

PCMS_ROUTINGERROR
PCMS_OPTERROR

PCMS_OPTHUB
PCMS_OPT2STOPS
PCMS_OPT3STOPS

PCMS_NOTENOUGHSTOPS
PCMS_BADNETDIR
PCMS_LOADGRIDNET
PCMS_BADOPTIONDIR
PCMS_DISCONNECTEDNET
PCMS_NOTRUCKSTOP
PCMS_INVALIDREGIONID
PCMS_CLOSINGERROR

Value

101
102
103
104
105
106
107
108
109
110
111

112
113

114
115

116
117
118

119
120
121
122
123
124
125
126

Server could not properly
initialize internal routing
component

Server could not properly
initialize internal routing
component

Message

Invalid pointer

The INI file was not found

Could not load the INI file

Could not load location database
Could not load the network database
Too many open trips (limit=8)

Invalid trip 1D

Invalid server ID

Invalid RootDir setting in INI file
Invalid MetaNetDir setting in INI file
License infraction: too many users, or
licenses not found

The trip is not ready to calculate
Invalid place name (city, state not
found)

Calculation failed: portions of trip are
invalid

Optimization failed: portions of the trip
are invalid

Cannot optimize a trip in HUB mode
Not enough stops to optimize the trip
Not enough stops to optimize without
changing destination

Not enough stops to calculate the trip
Bad network directory

Error loading gridded network

Bad option directory

Disconnected network

Truck inaccessible stop

Invalid region ID

Closing error
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Appendix F: Technical Implications of PC*MILER | Tolls

To accommodate the extra space needed for requesting and receiving Tolls
Cost data, the request and response packet layouts were increased in size and
the size of the response data queues was increased as detailed below.

Third party or In-house transportation software must be
modified to utilize PC*MILER-AS400 with the Tolls Cost
component. PC*MILER-AS400 with the PC*MILER|Tolls add-on module
cannot replace previous versions of PC*MILER-AS400 without programming

changes. See Chapter 7, Using PC*MILER|Tolls With Other Transportation
Software, for more information.

Notes For Existing PC*MILER-AS400 Users:

* A setof 10 new trip parameters has been inserted into all of the
request and response packets.

* Allreturn types (CP, SR, HR) were expanded to hold Tolls Cost
information. CP was expanded by 7 characters, SR by 77, and HR by 63.

For PC*MILER|Tolls, the ROUTEINFO portion of the HS return was increased
by seven characters and the number of ROUTEINFO sets per response packet
was increased from three to nine to improve performance. For users who are
upgrading from Version 15 or less, see NOTE below for previous changes.

* Output Data Queues sizes were lengthened from 1024 to 1048.

» Data Area “TLLALK” (renamed from COMALK) was modified to store a
default setting for Tolls Cost requests.

* “Old mode” or short city names (22 characters) are not supported.

NOTE: In Version 16, the ROUTEINFO portion of the HS return was
increased by 25 characters and the number of ROUTEINFO sets per
response packet was decreased from four sets to three. Route Number was
increased 15 characters from 20 to 35 (Highway, Road or Street Name), and
Interchange City or Junction was increased 10 characters from 28 to 38.

New for Version 31:

There are no longer separate builds of the Distance Server Executable
(Srv32.exe) for Tolls and Non-Tolls installations. The Distance Server will now
check the first request that it receives after startup to determine the correct
response format to use. Switching between Tolls and Non-Tolls is simply a
matter of configuring Srv32.exe to point to a Tolls (ALKTLL) or Non-Tolls
(ALKWIN) Library and then restarting Srv32.exe as follows:
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1. Click the File dropdown menu, choose ‘Change Library/Data
Queue’ and change the Library as necessary. Restart Srv32.exe
after the Data Queue value has changed.

Be sure to wait for this message before the restart:

Information >

The users on the AS400 should restart their PC*MILER interactive software now
that the queue name has changed.

2. Change the Library or Data Queue to one that will be receiving Tolls
Requests.

Running Both a Standard Highway and Tolls Cost Version:

1. Make a copy of c:\windows\pcmserve.ini and rename the copy to
“pmwssrv.ini”.

2. Make a copy of c:\windows\pcmsrv32.dll and rename the copy to
“pmwssrv.dll”. Edit c:\\windows\pmwsstrv.ini in Notepad and set the
Library=value from “ALKWIN” to “ALKTLL,” or from “ALKTLL" to
“ALKWIN?”. If your existing Library= value is an ICC library, you
must change it to another library.

3. Create a shortcut to Srv32exe: Set the command line parameter to
2 as below.

C:\ALK Technologies\pcmiler31\as400\SRV32_hwy.exe <space>2
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Appendix G: Renamed Program Objects

PC*MILER-AS400 with the optional Tolls Cost component (PC*MILER|Tolls) is
a modified version of the standard PC*MILER-AS400 version. The following
objects have been renamed to avoid conflicts with existing PC*MILER
products. NOTE: Some objects have been renamed twice to adhere to an
updated naming policy.

AIKWIN library = ALKMVS = ALKMTL

ALKWIN/Miinqgc = ALKMTL/TOLLINQ (RPG Mileage Inquiry Program)

ALKWIN/Miinqgc = ALKMTL/TOLLINQC (CL program that creates a response
data queue and then calls ALKMTL/MTLIINQ)

PCMILER Cmd = PCMTLL Cmd (Calls ALKTLL/ TOLLINQC)

External Data Structures

Used for sending and receiving trip information to/from data queues.
ALKWIN/MISEND = ALKTLL/NWSEND = ALKTLL/TLSEND
ALKWIN/MIRESP = ALKTLL/NWRESP = ALKTLL/TLRESP
ALKWIN/DRAW = ALKTLLL/TLDRW

ALKWIN/MISEND2 = ALKTLL/TLSEND2 added for V22 to include specific
field mappings from Borders Open/Closed and Use Ferry Distance flags. These
data structures are not used by ALK at this time.

Print File
ALKWIN/MIINQPF = ALKTLLL/TLINQPF

Stop (City) Validation

ALKWIN/CITALK = ALKTLL/CITTLL (RPG program that parses user input and
calls VTLADR for PC side validation)

ALKWIN/VALADR = ALKTLL/VTLADR

Saved Routes (Turn by Turn Instructions) and Trips

ALKWIN/ROUTES = ALKTLL = RTESTL (Saved Driections)
ALKWIN/STOPS = ALKTLL/STPTL (Saved Trips)

ALKWIN/LOADST = ALKTLL/LOADTL (RPG Program Loads Saved Trips)
ALKWIN/SAVEST = ALKTLL/SAVETL (RPG Program Saves Trip)

Storage of Trip Parameters

ALKWIN/COMALK = ALKTLL/COMTLL (Data Area for storing startup Trip
Parameters)

ALKWIN/Config = ALKTLL/TLLFIG (Program for setting Trip Parameters)

Display Files
ALKWIN/CONFIGD = ALKTLL/TLLFIGD

ALKWIN/MINQD = ALKTLL/TOLLINQD
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ALKWIN/STOPSD = ALKTLL/STPTLD
ALKWIN/SAVESTD = ALKTLL/SAVETLD
ALWIN/VALHLPD = ALKTLL/VALHTLD
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Appendix H: Setting Toll Discount Program Membership

Toll Discount membership is set on your PC Mileage Server. Changes are
made within the desktop PC*MILER program (C:\ALK Technologies\
pcmiler31\ App\ pcmwin32.exe). On your Mileage Server PC:

1. Click Start-> All Apps (or equivalent on your system) - PCMILER 31>
PCMILER 31 (alk.pcmiler.exe).

2. Click File=> Application Settings.

3. Click Tolls.

4. Check the appropriate boxes as pictured below.

5. Exit alk.pcmiler.exe.

105

W Application Settings - m} X

General Tolls
Fuel Prices Currency 1USD in CAD
Geocoding US Dollars - $1.293
Proxy Discount Programs
Report 407 ETR Transponder GeauxPass SunPass
Road Speeds A23 Transponder Goed To Go TollTag
Route Casts A30 EXPRESS Transponder GO-PASS TReO
Tolis i BreezeBy 1-PASS TiTag
s Cruise Card K-TAG Wabash Pass

Downbeach Express Pass Laredo Trade Tag

E-Pass LeeWay

E-Pass Canada MACPASS

ExpressPass NC Quick Pass

EXpressToll NEXPRESS TOLL

EZ Tag Palmetto Pass

EZPass Peach Pass

EZPass-MA PikePass

EZPass-NJ Quickpass

EZPass-WV Riverlink

FasTrak StraitPASS

Select All Deselect All

State/Country Distance Report

[C] Show Cash and Discount Program Breakdown

@ Apply Save Cancel

After making changes to your Discount settings and exiting PC*MILER, you
must shut down and restart your mileage server (srv32.exe):

Click Start-> Programs (or equivalent) > PCMILER 31> AS400 Interface.

The AS400 Interface (srv32.exe) only reads optional settings at Startup.
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Appendix I: Setting the Default Cost Per Mile or Kilometer

For users who interpret the trip cost value as the trip distance in hundredths
of miles or kilometers, the method for changing the default cost per mile or
kilometer was changed in Version 24. If upgrading from v. 23 or older, follow
the steps below.

Before starting the PC Distance Server (srv32.exe), first run the desktop
program (alk.pcmiler.exe) and follow these steps:

1. Click the File menu = Application Settings to open the Application Settings
dialog, then click the Route Costs

[ Application Settings

Loaded Empty
Route Costs i Miles per Gallon 648 6.48

Fuel Cost per Mile $0.32 $0.32

Other Cost per Mile $0.20 $0.20

Reset To Default

2. In the Route Costs Section, change the following values to O:
- Greenhouse Gases
- Fuel Cost Per Gallon
- Miles per Gallon
- Labor Cost Per Hour

3. Set Other Cost Per Mile Loaded and Empty to 1.
4. Click Save to save the edits and close the dialog.

5. Exit the Desktop PC*MILER program, then start your PC Distance Server.
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Appendix J: Running PC*MILER and PC*MILER]Tolls Builds
of the AS400 Interface on the Same PC

These instructions are intended for use if you are required to run a Tolls build and a Non-
Tolls build of the PC AS400 Interface (Srv32.exe, also formerly known as ‘Bart’) on the
same PC. Where noted, this method can also be used if you need to run two AS400
Interfaces connected to two different AS400s.

Background

You will be making copies of two files used by the AS400 Interface, copying and editing
your existing shortcut, and changing the Library= value in the appropriate INI file
(Change System=, User=, and Pass= values for dual AS400 configurations).

There are two types of shortcut or command line properties available to start your PC
AS400 Interface:

“C:\ALK Technologies\pcmiler31\AS400\Srv32.exe” 1
and

“C:\ALK Technologies\pcmiler31\AS400\Srv32.exe” 2

With 1, srv32.exe will link to C:\windows\pcmsrv32.dll and pcmserve.ini, while 2 will link
to c:\windows\pmwssrv.dIl and pmwssv.ini.

Step 1: Copy C:\Windows DLL and INI File

Make a copy of c:\\windows\pcmserve.ini and rename this copy to ‘pmwssrv.ini’. Make
a copy of c:\windows\pcmsrv32.dll and rename this copy to ‘pmwssrv.dll’.

Edit c:\windows\pmwssrv.ini and change the Library= value to ALKWIN or ALKTLL
or your custom library name.

For running a second instance of Srv32.exe servicing a second AS400, change the
System=, User=, and Pass= values to point to your second AS400. You will need to
configure your Client Access Express to see your second AS400. You may need to
change the Library= value as well.

Step 2: Create a New Shortcut

Create a shortcut to c:\alk technologies\pcmiler31\as400\Srv32.exe (default
location). Then edit the shortcut properties, changing the Target value to "C:\ALK
Technologies\PCMILER31\AS400\Srv32.exe".
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